Table of contents

TABLE OF CONTENTS ..................................................................................................................................................... - 2 -
THE CONNECTION BETWEEN COEUS PROPOSALS & PRIME FINANCIALS AWARDS AND SUBAWARDS .......... - 7 -
  BACKGROUND .............................................................................................................................................................. - 7 -
  BEFORE AND AFTER PRIME ........................................................................................................................................ - 7 -
    Pre-Prime (prior to 7/1/14) ......................................................................................................................................... - 7 -
    Post-Prime (after 7/1/2014) ......................................................................................................................................... - 7 -
    Coeus is Prime-enabled. What does that mean? ....................................................................................................... - 7 -
    What was converted from Coeus to PS Financials? ................................................................................................... - 8 -
    What was not converted from Coeus to PS Financials for existing awards? .............................................................. - 8 -
    What was not converted from Coeus to PS Financials for existing subawards? ...................................................... - 8 -
  AWARDS AND SUBAWARDS POST-PRIME QUICK GUIDE LINKS ........................................................................... - 9 -
TERMS AND DEFINITIONS ........................................................................................................................................... - 9 -
  PRINCETON PRIME .......................................................................................................................................................... - 9 -
  INFORMATION WAREHOUSE (IW) AND COGNOS ...................................................................................................... - 9 -
  UNIT AND DEPT ................................................................................................................................................................ - 10 -
INTRODUCTION TO COEUS PROPOSAL DEVELOPMENT ............................................................................................... - 10 -
  WHO SHOULD READ THIS .............................................................................................................................................. - 10 -
  COEUS PROPOSAL DEVELOPMENT DATA ENTRY .................................................................................................... - 10 -
  THE PROPOSAL PROCESS ................................................................................................................................................ - 10 -
ACCESSING COEUS ........................................................................................................................................................... - 12 -
  REQUESTING COEUS ACCESS ......................................................................................................................................... - 12 -
  COEUS PREMIUM VS COEUS LITE .................................................................................................................................... - 12 -
  LAUNCHING COEUS / DESKTOP ICON ISSUES ........................................................................................................... - 12 -
  LOGGING ON ..................................................................................................................................................................... - 12 -
  COEUS AND JAVA ............................................................................................................................................................ - 12 -
  LOGGING OUT .................................................................................................................................................................. - 13 -
  COEUS DAILY REBOOT SCHEDULE ................................................................................................................................. - 13 -
NAVIGATING THROUGH COEUS ....................................................................................................................................... - 13 -
  TOOLBARS .......................................................................................................................................................................... - 13 -
  MOVING BETWEEN WINDOWS ......................................................................................................................................... - 14 -
SEARCHING IN COEUS ....................................................................................................................................................... - 16 -
  USING THE SEARCH WINDOW .......................................................................................................................................... - 16 -
  ENTERING SEARCH VALUES IN FIELDS .......................................................................................................................... - 17 -
  FULL NAME SEARCHING ................................................................................................................................................ - 18 -
  FIRST AND LAST NAME SEARCHING .............................................................................................................................. - 19 -
  SEARCHING BY PROPOSAL NUMBER ............................................................................................................................. - 20 -
  TITLE SEARCHING ........................................................................................................................................................... - 20 -
  USING MULTIPLE LINES TO EXPAND THE SEARCH .................................................................................................... - 20 -
  SEARCH RESULTS ORDER .................................................................................................................................................. - 21 -
SEARCH RESULTS LIST ........................................................................................................................................................ - 22 -
  SORTING SEARCH RESULTS ............................................................................................................................................ - 22 -
  SAVING SEARCH RESULTS ............................................................................................................................................. - 22 -
  BUG: PROPOSALS DISPLAYED TWICE IN SEARCH RESULTS AFTER EDITING .......................................................... - 22 -
OVERVIEW OF THE PROPOSAL DEVELOPMENT PROCESS .............................................................................................. - 23 -
CREATING THE PROPOSAL DEVELOPMENT PROPOSAL ................................................................................................. - 24 -
  START A NEW PROPOSAL ................................................................................................................................................ - 24 -
  PROPOSAL TAB ................................................................................................................................................................. - 25 -
  Proposal Development Status Chart ............................................................................................................................... - 27 -
Adding Non-Personnel Items

Why Use the Red Baron for Personnel? Why Enter the Personnel Cost Directly on the Line Item?

Entering Personnel Items Using the Running Guy and the Red Baron

Overview

Personnel Cost Elements

What Every Box on the Budget Summary Tab Means

Methods for Entering Personnel Items

Adding Personnel Items Manually

Why Use the Red Baron for Personnel? Why Enter the Personnel Cost Directly on the Line Item?

How Coeus Calculates Personnel Salary and Employee Benefits

Budgets that Start on the 1st of the Month and End on the Last Day of a Month Using the Red Baron

Budgets that Do Not Begin and/or End on the 1st and/or Last Day of the Month Using the Red Baron

Figuring Out Employee Benefits for Budgets That Start on the 1st of the Month and End on the Last Day of a Month, Not Using the Red Baron

Adding Non-Personnel Items

Adding Most Non-Personnel Items

Adding Human Subjects Payments and Adding Animal Supplies Costs

Proposal Type Chart

Why Does Choosing the Right Proposal Type Matter?

Activity Type Chart
<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
</tr>
</tbody>
</table>
The Connection between Coeus proposals & Prime Financials awards and subawards

Background

Coeus is the software that Princeton uses for developing and tracking externally sponsored research proposals. Up until Prime go-live on 7/1/2014, award and subaward information was also housed in Coeus and fed to PS Financials. Since Prime go-live, award and subaward information is housed directly in PeopleSoft (PS) Financials. Data in the Coeus award and subaward modules was frozen as of mid-June 2014.

Coeus is composed of many modules. Users build proposals in the Coeus Proposal Development module with its own tracking ID. Once submitted and fully approved, Coeus automatically generates an Institute Proposal with another tracking ID. Proposals are finalized and electronically approved through Coeus before they are sent to the sponsor. Once funded, the proposal information is interfaced by ORPA Award Specialists to PeopleSoft Financials (PS Financials), where the award data is maintained. Subawards are also tracked in PS Financials.

Coeus also contains the IRB module, used by RIA to track human subject protocols.

Coeus was originally developed at MIT. There are ~50 schools around the country that use at least one Coeus module. Coeus is the Greek Titan of intelligence, and is not an acronym. Princeton started using Coeus in 1998 in ORPA, and then had a dept-by-dept rollout of the software in 2002.

Before and After Prime

Pre-Prime (prior to 7/1/14)
- Coeus was used for tracking proposals, institute proposals, awards & subawards
- Basic award and award budget data fed from Coeus to PS Financials 8.4 nightly
- The expenditures were tracked in PeopleSoft 8.4
- Depts had direct access to view Coeus award and subaward data
- Depts had IW access to view reports comparing Coeus award budget to PS expenditures (SPR)

Post-Prime (after 7/1/2014)
- Coeus is still used for proposal tracking, but is not used for tracking awards or subawards
- Coeus award and subaward modules were frozen as of mid-June 2014
- PS Financials 9.2 is used for tracking awards and subawards
- No direct dept access to PS Financials
- Depts view PS award and subaward data via IW reporting. IW reports contain one-day old data (except the NOA which is real time.) Fill out the Prime Access Request Form and submit it to the Financial Services Center to gain access to Prime award and subaward info.
- Directions on how to fill out the Prime Access Request Form are here.

Coeus is Prime-enabled. What does that mean?
- Most pre-Prime Coeus cost elements were inactivated, and many new Prime budget items were added. We didn’t inactivate all Coeus cost elements because we still need some of them for s2s, so that they map to the appropriate place on the Grants.gov detailed budget form. A chart is available in the budget section of this manual that shows the old Coeus cost elements and new PS budget items (i.e. BPG201 “Faculty Salaries” is now SALRF “Salary - Regular Faculty”).
• Any proposal submitted and approved before Prime go-live will still display the cost elements that were used at time of submission.
• If you copy an old proposal where the pre-Prime cost elements were used, Coeus will force you to replace all of the inactive pre-Prime elements with active cost elements.
• The pre-Prime 3 digit dept numbers displayed throughout Coeus were replaced by the post-Prime 5 digit dept number at the main level (“00 level”) for each dept.
• The PG numbers displayed throughout Coeus were not replaced.
• For any new awards set up in Prime, the PeopleSoft Award number will feed back to the Account Number box in the Coeus Institute Proposal module.
• If you had modify access to the Coeus award, award budget and/or subaward modules, your access is now view only.
• If you have view only access to the Coeus award, award budget and/or subaward modules, your access remains as view only.
• IRB staff only: IRB protocols at any point in the submission & review process pre-Prime can continue the IRB submission & review process after Prime goes live.

What was converted from Coeus to PS Financials?

• Awards active in FY14 and any closed children associated with those awards were converted from Coeus to PS Financials, but not all award info was converted
• Active subawards in FY14 were converted

What was not converted from Coeus to PS Financials for existing awards?

• The history of every increment and budget
  o The current cumulative amounts (obligated dollars, dates and budget) were converted
  o Anticipated totals and end dates were converted
• All comments on the Comments tab were not converted
• All attachments on the Attachments tab were not converted
• Not every term was converted (terms were condensed at conversion)
• Payment schedule was not converted
• All Institute Proposal numbers funding the award were not converted
  o Only the initial IP number was converted
• Cost share commitments were not converted. We will reach out to you for your cost shared awards.
• You can still view all the data above in the Coeus award and award budget modules, as appropriate.

What was not converted from Coeus to PS Financials for existing subawards?

• Subaward Purchase Orders for closed subawards were not converted
  o PO number for closed subawards will not appear on the NOA
• Subaward invoices approved in Coeus prior to 6/20/14 will remain in Coeus
  o Not converted to PeopleSoft
  o Do not appear on the Subaward Detail Report and Invoice Drill
• You can still view all the data above in the Coeus subaward module.
**Awards and subawards post-Prime quick guide links**

The current award and subaward info is in PS Financials. You can access that information through the Information Warehouse (IW), which contains one-day old data (except the NOA, which is the only real-time IW report). Fill out the Prime Access Request Form and submit it to the Financial Services Center to gain access to Prime award and subaward info. Directions on how to fill out that form are [here](#).

More information about award and subawards in the post-Prime era is available [on this page](#) and includes the following info:

- Use the **Award Quick Guide** to learn about:
  - The new Prime award structure
  - How to find obligated/anticipated dates/dollars on sponsored research reports
  - What the different award/project/activity statuses are and what they mean
  - How to view award and subaward attachments
- Read the **Converted Award Quick Guide** to find out:
  - How awards were converted from Coeus to PS
  - What data was not converted from Coeus to PS
  - How the Prime award structure differs from the Coeus award hierarchy
- The **Requesting Access to Sponsored Research Reports Guide** includes:
  - Definitions of the various Sponsored Research Reporting Access roles
  - Who has default access to Projects
  - How to fill out the Prime Financials Access Request form for sponsored research access.
- The **Subaward Invoice Approval Quick Guide** is:
  - A one-page guide on how to approve subaward invoices in Prime.
- The **Viewing Award and Subaward Attachments Guide** shows:
  - How to view award and subaward documents in Prime.
  - Troubleshooting instructions for when attachments don't want to open

---

**Terms and Definitions**

**Princeton Prime**

Princeton Prime is a broad term that encompasses many different systems, such as:

- Concur
- LA
- Marketplace
- Information Warehouse (IW)
- PeopleSoft Financials (PS)

There are several modules within PS Financials. Sponsored research awards are entered into PS Grants by ORPA Award Specialists.

**Information Warehouse (IW) and Cognos**

Reporting is done out of the Information Warehouse (IW). IBM Cognos is the software the IW uses for reporting.
Unit and Dept

Coeus refers to department numbers as “units”. This is because Coeus was developed at MIT and at MIT, departments are called units. In Coeus, units and departments are the same thing.

- Some depts have their sponsored research at the main dept (APC, GEO)
- Some depts have a research subdept (MOL)
- Some depts have subdepts for particular professors, but not all (CHM)

Regardless, all Coeus proposals are created and submitted at the dept's “main level” (“ends in 00” level). When awarded, the dept determines the appropriate subdept, as applicable.

Introduction to Coeus Proposal Development

Who Should Read This

The Proposal Development User Guide for Coeus is intended for users who create, modify, or approve proposals.

Coeus Proposal Development Data Entry

Proposal Development data entry into Coeus can be divided into four steps:

- Proposal Detail Entry: Enter the basic details of your proposal.
- Budget Creation: Create the budget (or multiple budget versions).
- Narrative Upload: Upload documents such as the narrative, project summary, facilities, equipment, bibliography, etc.
- Finalize & Submit for Approval: Finalize your proposal, which includes answering the Yes/No Questions and certifying the investigators. Then, submit the proposal for approval routing.

The Proposal Process

The proposal flows through Coeus and into PS Financials as follows:

Coeus proposal development module (data is entered by dept) → Coeus institute proposal module (auto generated after ORPA approval) → PS Financials (If awarded, proposal data is interfaced from Coeus to PS Financials and maintained by ORPA)
In detail:

PI has an idea and wants to apply for funding from a sponsor
PI writes a proposal that includes: Why should the sponsor choose them? What will they do? What is their budget? What is their budget justification?

The dept person enters the proposal in the Coeus Proposal Development module and in the sponsor's forms. The proposal's status is "in progress".
Once the department submits the proposal for approval, its status is "approval in progress".

Dept and collaborating departments approve/reject proposal in Coeus.
If it is rejected, the proposal status is "rejected". The dept makes changes and submits through the approval map again. The proposal status is then "approval in progress".

After all departments approve, the proposal is reviewed by ORPA in Coeus. If ORPA rejects the proposal, the dept makes changes & submits through the entire approval map again.
If ORPA approves, an Institute Proposal (IP) is generated. The proposal status is Submitted* and the IP status is pending. The proposal is submitted to the sponsor.
(*If the proposal meets criteria for University Research Board (URB) review, the status is "post-submission approval." When the URB approves, the status is Submitted.)

Wait to hear from the sponsor.
If the proposal is declined, ORPA updates the IP status to "Declined."
If the proposal is funded, ORPA interfaces the proposal information from Coeus to PS Financials. The PS Award ID then interfaces at 5am the next morning back to the Coeus IP module, which also flips the IP status to Funded at the same time.
If the award contains subcontracts, ORPA will enter approved subaward initiation requests into PS Financials.
Accessing Coeus

Requesting Coeus Access

The new user’s dept, business, finance, or grant manager should fill out the Coeus new user request form on the Coeus Forms page and email it to coeus_help@princeton.edu.

Coeus Premium vs Coeus Lite

There are two versions of Coeus: Premium and Lite.

- Coeus Premium is used by departments for developing and submitting proposal development proposals, and can be used by departmental approvers for approving proposals on their computers.
- Coeus Lite is used by departments and departmental Chairs for approving proposals on computers, tablets or smart phones.

Launching Coeus / Desktop Icon Issues

Launch Coeus Premium or Lite from the Coeus home page.

Coeus Premium will create a desktop icon for you that you can use to launch Coeus. However, sometimes the icon stops working for no reason at all. You can either remove the icon and only use the link on the Coeus home page to launch Coeus (similar to launching Prime—there is no desktop icon for Prime), or you can follow the instructions in the Installation and Troubleshooting Guide to fix the desktop icon issue.

Logging on

Your login for both Coeus Premium and CoeusLite is your LDAP login. This is the same user name and password you use to log onto your Princeton computer and check your Princeton email.

If a Coeus Message screen appears after you log on, either click on ok or check the box to not see that message again (it will not appear again til the next upgrade).

If you have trouble logging on to Coeus, call the Coeus Hotline at 8-7373 or email coeus_help@princeton.edu.

Coeus and Java

Coeus requires Java 1.8 to run. More information about Java, and associated quirks with Java 1.8 on PCs and on Macs, is in the Installation and Troubleshooting Guide on the Coeus home page.
Logging Out

Coeus Daily Reboot Schedule

The Coeus production server is rebooted every morning at 5am. The reboot takes approximately 2 minutes, so Coeus will be down for that period of time daily.

Navigating through Coeus

All Coeus features can be accessed by either menus or toolbars interchangeably.

Toolbars

When you first launch Coeus, one toolbar is displayed. This toolbar applies to the application as a whole.

To display the names of the toolbar buttons, hover the cursor over the button for a few seconds. The name of the button will appear.
A second row of toolbar buttons is displayed when you open a module. The second toolbar applies to the module you're working in.

A toolbar guide is available on the Coeus home page that explains the functionality of each button.

Buttons may be grayed out if you don't have rights.

**Moving Between Windows**

As you work in Coeus, windows open on top of other windows. If you don't want to close your currently open windows, use the Window menu to see a list of open windows. Click on the one you want to see.

Click on the Cascade button to fan all of your open windows like a deck of cards.
Click on the Layer button to layer your windows again.
Searching in Coeus

Using the Search Window

The search window is displayed when you click on any module in the first toolbar.

The query will be applied to only those proposals where the current user, KBURKHAR plays one of the selected proposal roles.

Selected Roles
Access Proposal Person Institutional Sale
Aggregator
Approver
Budget Creator
Conflict of Interest Dept Viewer
Modify Proposal Roles

Available Roles

When you're already in a module, you can click on the search icon in the second toolbar to search again.

(You don't need to close the module and reopen it to access the search button again)
Entering Search Values in Fields

The * wildcard is your friend with Coeus searching. Use the * to:

- Take the place of zeros in proposal number searches
  - *12345 instead of 00012345
- Take the place of a person's full name
  - sarm* instead of Sarmiento
- Find a proposal by a word in the title
  - *microscope* to find The History of the Microscope in New Jersey
- Find a sponsor name using part of their name
  - *science* to find National Science Foundation

When searching in text fields, you can type part of the word you are searching for, surrounded by stars. For example, if you are searching for all proposals where McGill is a PI, you can type *mcgill* in the Investigator field to locate all proposals which contain McGill. (Text searching is not case sensitive.)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Use to Locate</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>All values that include the text that follows the * wildcard symbol. You can use the wildcard * at the beginning or end of a text string, to indicate that there may be any number of characters before or after the text. The search is not case sensitive.</td>
<td>McGill* in the Investigator field will find McGillicuddy, John, but not Walters, Gillian. <em>Gilli</em> will find McGillicuddy, John, or Walters, Gillian.</td>
</tr>
<tr>
<td>No operator</td>
<td>All values that equal the text entered in the search field. Wildcards will be treated as text.</td>
<td>23300 in the Unit Number field will find only department 23300.</td>
</tr>
<tr>
<td>&lt;</td>
<td>All values that are less than the value that follows.</td>
<td>&lt; 00025300 in the Proposal No field will find 00020000, but not 40100000 or 140</td>
</tr>
<tr>
<td>&gt;</td>
<td>All values that are greater than the value that follows.</td>
<td>&gt; 00020000 in the Proposal No will find 00024000, but not 00000200 or 00000040</td>
</tr>
<tr>
<td>&lt;=</td>
<td>All values that are less than or equal to the value that follows.</td>
<td>&lt;= 00030000 in the Proposal No field will find 00030000, 00029900, but not 300</td>
</tr>
<tr>
<td>&gt;=</td>
<td>All values that are greater than or equal to the value that follows.</td>
<td>&gt;= 00030000 in the Proposal No field will find 00030000, but not 00029900</td>
</tr>
</tbody>
</table>
**Full Name Searching**

Coeus stores full names as:
- **Last, First Middle Initial**
- Sarmiento, Jorge L

<table>
<thead>
<tr>
<th>PD and IP search screen</th>
<th>Investigator or PI or Full Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sarm*</td>
<td></td>
</tr>
<tr>
<td>sarmiento*</td>
<td></td>
</tr>
<tr>
<td>sarmiento, j*</td>
<td></td>
</tr>
<tr>
<td>sarmiento, jorge*</td>
<td></td>
</tr>
<tr>
<td>sarmiento, jorge l</td>
<td></td>
</tr>
</tbody>
</table>

The above shows all the different ways of searching for Jorge Sarmiento in the Investigator box in the Coeus Proposal Development and Institute Proposal screens. Depending on your investigator’s name, you can figure out the fastest way of finding his/her name in the fewest characters possible.
**First and Last name searching**

Here are all the different ways to search for Jorge Sarmiento when the First and Last Name fields are separate fields in Coeus.

![Person Search](image)

NOTE: If the search results returns proposals that do not list Jorge Sarmiento in the PI column, that is because Sarmiento is a co-PI on the proposal. The search results field shows the lead PI for the proposal.
Searching by proposal number

Use the wildcard * in place of the three zeros in front of the proposal number to more quickly find your proposals. I like using the * over the numeric keypad on my keyboard to search really quickly.

Title Searching

Using the wildcard * before and after search terms will return the most number of results. This kind of searching works for any text searching in Coeus.

Using Multiple Lines to Expand the Search

You can use more than one line in the search screen at one time. For example, you can look up two proposals at the same time.
NOTE: If you enter a search term (such as a number) on the first line of the search screen for the Proposal Development, Institute Proposal, Award and Subcontract modules, then want to enter a second number in the next row, you have to press the down arrow twice to get the cursor to go to the second line. This problem only happens on the first line of the search screen. Or, you can click into the next row instead of using the down arrow.

Search Results Order

For the Proposal Development and Institute Proposal modules: When a search returns more than one search result, the proposals will be listed in reverse numerical order, so recent proposals will be listed first.
Sorting Search Results

Click on a header to sort the search results by that column

Saving Search Results

Save your search results to Excel to sort any way you want!

Bug: Proposals displayed twice in search results after editing

While testing P2, we found that sometimes, after editing a proposal and closing it, the proposal was listed twice in the Proposal Development list screen. In the example below, the proposal number is the same. The PI is listed on one row but not the other. It appears to just be a screen display issue. There is only one version of the proposal and you can select either line for editing.
Overview of the Proposal Development process

- **Start proposal, fill in details**
  - Enter details in proposal tabs

- **Create and finalize budget**
  - Several budget versions can be created
  - Select one budget as final and complete

- **Upload attachments (narratives)**
  - Upload PDFs of all attachment (narrative) files

- **Complete the proposal**
  - Answer Yes/No Questions
  - Certify the investigators
  - Check and finalize narrative and budget

- **Submit proposal for departmental and ORPA approval**
  - Submit
  - Approval maps are set for each department participating in the proposal
Creating the Proposal Development proposal

Proposal information is entered by departmental administrators (such as business managers, grant/financial managers, department managers, and faculty assistants) in the Coeus Proposal Development module.

Start a New Proposal

Coeus refers to department numbers as “units”. This is because Coeus was developed at MIT and at MIT, departments are units. In Coeus, units and departments are the same thing. All Coeus proposals are created and submitted at the dept’s “main level” (“ends in 00” level). When awarded, the dept determines the appropriate subdept, as applicable.
The proposal tab is used for entering basic information about the proposal such as title, proposed start & end dates, and sponsor.
<table>
<thead>
<tr>
<th>Proposal Tab Field</th>
<th>What it means/how to fill it in</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Proposal No</strong></td>
<td>This is your Proposal Development Proposal number -- a sequentially assigned number without any meaning. Write this number down because knowing the Coeus proposal number is the fastest way to find the proposal.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>See Proposal Development status chart below.</td>
</tr>
<tr>
<td><strong>Proposal Hierarchy icon</strong></td>
<td>See the proposal hierarchy section of this guide for the definition of a proposal hierarchy.</td>
</tr>
<tr>
<td>• Red X: Not part of a hierarchy</td>
<td>• + sign: Parent proposal in a hierarchy</td>
</tr>
<tr>
<td>• - sign: Child proposal in a hierarchy</td>
<td></td>
</tr>
<tr>
<td><strong>Narrative icon</strong></td>
<td>• Red X: No narrative files have been uploaded</td>
</tr>
<tr>
<td>• Blue</td>
<td></td>
</tr>
<tr>
<td><strong>Budget icon</strong></td>
<td>• Red X: No budget has been entered</td>
</tr>
<tr>
<td>• Blue</td>
<td></td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Title of Proposal as provided by PI</td>
</tr>
<tr>
<td><strong>Start Date</strong></td>
<td>Anticipated Proposal Start Date</td>
</tr>
<tr>
<td>Enter date in any format; Coeus will format it for you when you click or tab out of the field</td>
<td></td>
</tr>
<tr>
<td><strong>End Date</strong></td>
<td>Anticipated Proposal End Date.</td>
</tr>
<tr>
<td>Do not make the End Date the same day of the year as the proposal start date. If the proposal start date is 12/1 and the proposal end date is 12/1, there will be an additional budget period that is 1 day long.</td>
<td></td>
</tr>
<tr>
<td><strong>Proposal Type</strong></td>
<td>See Proposal Type chart below</td>
</tr>
<tr>
<td><strong>Activity Type</strong></td>
<td>See Activity Type chart below</td>
</tr>
<tr>
<td><strong>Anticipated Award Type</strong></td>
<td>Not used.</td>
</tr>
<tr>
<td><strong>Sponsor</strong></td>
<td>Source of the funding. If you know the Coeus code for the sponsor, type it in the box including any leading zeros; otherwise, click on the Search button next to the Sponsor field to find the sponsor code. After typing in the sponsor code or selecting it in the search results, Coeus will fill in the sponsor’s name next to the box.</td>
</tr>
<tr>
<td>If you can’t find the sponsor, it might be new. Email the sponsor information (name, sponsor type, address, and phone/email info) to <a href="mailto:coeus_help@princeton.edu">coeus_help@princeton.edu</a>. In the meantime, you can keep working on your proposal without a sponsor filled in.</td>
<td></td>
</tr>
<tr>
<td><strong>Prime Sponsor</strong></td>
<td>Only fill this field in if Princeton is a subcontract recipient. If NSF grants an award to Harvard, and Harvard subcontracts out part of the work to Princeton, NSF is the prime sponsor and Harvard is the sponsor.</td>
</tr>
<tr>
<td><strong>Program Title</strong></td>
<td>The sponsor’s program / notice of opportunity / solicitation title.</td>
</tr>
<tr>
<td><strong>Notice of Opportunity</strong></td>
<td>How did your PI learn about this opportunity?</td>
</tr>
<tr>
<td>• RFP: Request for Proposal</td>
<td>• Program Officer</td>
</tr>
<tr>
<td>• Publication</td>
<td></td>
</tr>
<tr>
<td><strong>Funding Opportunity Number</strong></td>
<td>Sponsor’s identifying number for this opportunity. Usually listed on the sponsor’s notice of opportunity.</td>
</tr>
<tr>
<td><strong>Agency Program Code</strong></td>
<td>Used mainly for NSF and sometimes for s2s.</td>
</tr>
<tr>
<td><strong>Agency Routing Identifier</strong></td>
<td>Mainly used for s2s; see the s2s guide.</td>
</tr>
<tr>
<td><strong>Award No.</strong></td>
<td>Not used post-Prime. Pre-Prime, this was the Coeus award number.</td>
</tr>
</tbody>
</table>
### NSF Code
Not used.

### Original Proposal
For a renewal of an existing award, supplement to an existing award, a revision of an existing award, or a preaward revision, this is the original Institute Proposal number (not Proposal Development number).

### Subcontract box
If there will be subcontracts to other institutions if this proposal is awarded, then check this box. Do not check this box if Princeton is the subcontract recipient.

### CFDA Number
For federal proposals only, this is the Catalog of Federal Domestic Assistance number. Usually listed on the sponsor’s notice of opportunity.

### Agency Div Code
Used mainly for NSF and sometimes for s2s.

### Previous Grants.gov Tracking ID
For s2s proposals that errored; see the s2s guide.

### Proposal Development Status Chart

<table>
<thead>
<tr>
<th>Proposal Development Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>In progress</td>
<td>Still working on the proposal</td>
</tr>
<tr>
<td>Approval in progress</td>
<td>Submitted for dept. approval</td>
</tr>
<tr>
<td>Submitted</td>
<td>Approved by ORPA; submitted by ORPA to the sponsor</td>
</tr>
<tr>
<td>Rejected</td>
<td>Rejected by dept. or ORPA; needs to be corrected and submitted again for approval</td>
</tr>
</tbody>
</table>
| Post-submission Approval   | • Approved by ORPA and submitted to sponsor but meets University Research Board (URB) readership criteria  
   • Over $5 million in total costs  
   • Biosafety level 3 handling  
   • Countries embargoed or restricted  
   • Unusual implications for the university  
   • 2 URB members review the proposal  
   • After URB approves, the status is Submitted  
   • If URB rejects, the status is Post-submission Rejection |
## Proposal Type Chart

<table>
<thead>
<tr>
<th>Prior Coeus Proposal Type</th>
<th>Renamed Coeus Proposal Type (as of 11/1/16)</th>
<th>Revised Coeus Proposal Type Definition (as of 11/1/16)</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>New</td>
<td>• New application</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For competitive sponsor resubmissions (such as NIH) with a new deadline</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NSF renewals should be proposal type New</td>
</tr>
<tr>
<td>Resubmission</td>
<td>Preaward revision</td>
<td>• Amended or revised application before the proposal is awarded</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Do not use this type for proposals that have already been awarded and set up in PeopleSoft.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Using this type overwrites an already-approved Coeus institute proposal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Used for documentation of congruency letters/special review tab updates</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Examples</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Sponsor requests changes to an existing, submitted proposal before issuing the award, such as budget changes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o NSF requests a revised proposal budget before issuing the award</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Do not use for Adobe or ASSIST NIH resubmissions. NIH “01A” resubmissions should be submitted as New applications in Coeus. For s2s NIH resubmissions, you may use type Preaward Revision in Coeus (GCAs: when prompted, you should choose the option to generate a new IP number.)</td>
</tr>
<tr>
<td>Renewal</td>
<td>Renewal of an Existing Award</td>
<td>• An application requesting additional funding for a period subsequent to that provided by a current award.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Example</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Existing 5 year award is ending this year. PI is applying for another 5 years of funding.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Typical proposal type for DOE and some industry sponsors for existing awards</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NSF renewals should be proposal type New in anticipation of a new sponsor award number</td>
</tr>
<tr>
<td>Revision</td>
<td>Supplement to an Existing Award</td>
<td>• Supplemental (additional) funding for an existing award that has been set up in PS Financials</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Includes requests for additional funding to meet increased or new costs that are within or related to the scope of the approved application,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Overlaps the existing period of performance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Existing award was originally funded for $100k. PI applies for additional funding of $50k that was not part of the sponsor's original anticipated award amount.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SF424 R&amp;R form uses the term “Revision” for this scenario. Selecting Supplement will map to Revision on the SF424 R&amp;R form for s2s submissions.</td>
</tr>
<tr>
<td>Post-Award Revision (not Grants.gov)</td>
<td>Revision of an Existing Award</td>
<td>• Revising budgets for any of the years on an existing award.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• This type should not be used for additional funding.</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>This type should be used when the sponsor requests a revised budget after the proposal has been awarded and has been set up in PS Financials.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Examples:</td>
<td>The sponsor has requested a revised budget for year 2 after already awarding year 1.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The sponsor requests a spending plan every year for an existing award.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The sponsor requests a budget each year to reflect the current fringe rate for an existing award.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sponsor has a budget reduction and is requesting a revised, reduced budget. This type routes directly to ORPA and does not go through the departmental approval path.</td>
<td></td>
</tr>
<tr>
<td>White Paper / Letter of Intent / Pre-Proposal</td>
<td>This type must be entered in Coeus if it requires ORPA approval.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Also known as a pre-proposal, a white paper / letter of intent is a condensed version of a proposal.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The sponsor determines if the PI should submit a full proposal based on the information in the pre-proposal.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This proposal type might not have a budget. If so, set the $0 budget to final and complete in order to submit the proposal.</td>
<td></td>
</tr>
<tr>
<td>Non-Funded Agreement</td>
<td>Use this type for non-funded agreements.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Non-funded data agreement</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Non-funded research collaboration agreement</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Non-funded Memorandum of Understanding (MOU)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Non-funded Non-Disclosure Agreement (NDA)</td>
<td></td>
</tr>
<tr>
<td>Task Order</td>
<td>Used when the funding on the main award has already been received and Princeton is awarding new projects based on the outcome of an internal competition. (Must have ORPA Director’s approval)</td>
<td></td>
</tr>
</tbody>
</table>

- 29 -
Why does choosing the right proposal type matter?

Proposal types are the basis for many reports

- Trustees
- URB
- DFR

Certain proposal types are excluded

- Revision to an Existing Award
- Pre-proposal

Activity Type Chart

<table>
<thead>
<tr>
<th>Description</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organized Research</td>
<td>Research</td>
</tr>
<tr>
<td>Equipment</td>
<td>Equipment</td>
</tr>
<tr>
<td>Conference/Workshop/Travel</td>
<td>Conference/Workshop/Travel</td>
</tr>
<tr>
<td>Fellowship</td>
<td>Fellowship</td>
</tr>
<tr>
<td>Instruction/Curriculum</td>
<td>Example is NJ STEP program involving training prisoners.</td>
</tr>
<tr>
<td>Training Grant</td>
<td>Training grants such as NIH T32s and NSF RGTs.</td>
</tr>
<tr>
<td>Other Inst'l &amp; Sponsored Activ</td>
<td>Other activity that does not fall into the above categories. Example is Programming for the Art Museum</td>
</tr>
</tbody>
</table>
The Organization tab should be completely ignored unless your proposal is s2s; see the s2s guide.

Do not change any information on this tab unless you are doing s2s as per the s2s guide. By default, The Trustees of Princeton University is the Organization, the ORPA Director is listed, and NJ-012 is the congressional district. Do not change this default information.
The Mailing Info Tab

The Mailing Info tab is used for recording the Sponsor's Deadline Date. If your dept prints the generic cover page, fill in the Mailing Address too.

<table>
<thead>
<tr>
<th>Mailing Info Tab</th>
<th>What it means/how to fill it in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Sponsor's deadline date. The proposal is due to your ORPA rep 5 business days before this date.</td>
</tr>
<tr>
<td>Mailing Address</td>
<td>Only fill this in if your dept prints the generic cover page; the generic cover page will not print unless this address is filled in (and there is a budget marked as final). Use the magnifying glass 🕵️ to find the mailing address of the person at the sponsor who is receiving the application. Use the eraser button 🕴️ to remove the address completely from the proposal. If the person or address you need is not in the rolodex, you can add the person to the rolodex; see Rolodex section of this guide.</td>
</tr>
<tr>
<td>Other fields</td>
<td>Mostly self-explanatory; you can fill them in if you want to or just leave them blank; they are not required and not used by ORPA.</td>
</tr>
</tbody>
</table>
The Investigator Tab

Who is listed on this tab?

• For non-s2s proposals, the Investigator tab lists only Princeton PIs and Co-PIs for this proposal.
• If the proposal is s2s, this tab may contain non-Princeton co-PIs; see the s2s guide.

Who is not listed on this tab?

• Do not list TBA people.
• Do not list the same person on the Investigator tab and the Key Person tab.

NIH Fellowship?

• non-s2s: List the Professor on the Investigator tab and the Student on the Key Person tab
• s2s: List the Student on the Investigator tab and the Professor on the Key Person tab

Investigators must be certified on this tab before submitting the proposal.

A person's home unit (as per PS HCM) is listed by default at the bottom of the panel; do not delete anyone's unit.

If the proposal is through a center or program, add the center/program unit to the lead PI.

Proposals will route to all depts listed on this tab for approval. Do not remove any depts from this tab.
<table>
<thead>
<tr>
<th>Mailing Info Tab</th>
<th>What it means/how to fill it in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hand/claw icon</td>
<td>The unit info at the bottom of the screen corresponds to the person highlighted at the top of the screen.</td>
</tr>
<tr>
<td>Person Name</td>
<td>List the lead PI first. Add co-PIs as needed.</td>
</tr>
<tr>
<td>PI box</td>
<td>This column should be labeled “Lead PI”. Check this box for the person who is the lead PI.</td>
</tr>
<tr>
<td>Multi PI box</td>
<td>This is for NIH multi-PI s2s proposals only. Check this box for every person listed on this tab, including the lead PI, only if this proposal is an NIH multi-PI s2s proposal. Otherwise, leave all multi-PI boxes unchecked.</td>
</tr>
<tr>
<td>Faculty</td>
<td>This box is automatically checked if the feed from PS HCM lists this person as a Faculty member.</td>
</tr>
<tr>
<td>Effort</td>
<td>Not used. Do not fill in.</td>
</tr>
<tr>
<td>Academic Year Effort</td>
<td>Not used. Do not fill in.</td>
</tr>
<tr>
<td>Summer Year Effort</td>
<td>Not used. Do not fill in.</td>
</tr>
<tr>
<td>Calendar Year Effort</td>
<td>Not used. Do not fill in.</td>
</tr>
<tr>
<td>Certify</td>
<td>Red X: PI is not certified. Green checkmark: PI is certified. Use the Certify button to certify investigators.</td>
</tr>
<tr>
<td>Lead Unit</td>
<td>Must be checked for the person checked as Lead PI</td>
</tr>
<tr>
<td>Unit Number/Unit Name</td>
<td>Unit will be the Investigator’s home unit as listed in PS HCM. If the proposal is through a center or program, <em>add</em> your unit number to the person’s home unit with the Add Unit button.</td>
</tr>
<tr>
<td></td>
<td>The proposal will be routed to all units listed on this tab.</td>
</tr>
<tr>
<td>Add</td>
<td>Although it is tempting to use the Add button to add someone, use the Find Person button instead. If you do use the Add button, you’ll have to click on Find Person to find the persons or use the Delete button to delete the row.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the row</td>
</tr>
<tr>
<td>Find Rolodex</td>
<td>Only use this button if your Investigator is coming to Princeton but is not at Princeton yet and can’t be located in “Find Person”, or if your proposal is s2s and your PI or co-PI is a non-Princeton person.</td>
</tr>
<tr>
<td></td>
<td>If the person cannot be located with “Find Rolodex”, then you’ll need to add them to the rolodex; see the rolodex section.</td>
</tr>
<tr>
<td>Find Person</td>
<td>Click on this button to search for your Princeton investigators</td>
</tr>
<tr>
<td>Certify</td>
<td>Click on this button to Certify investigators; each person on this tab needs to be certified. After you certify a person and press save, this red X will change to a green checkmark.</td>
</tr>
<tr>
<td>Credit Split</td>
<td>Not used.</td>
</tr>
<tr>
<td>Add Unit</td>
<td>If the proposal is through a program or center, use this button to add the proposal home unit to the Lead PI’s list of units.</td>
</tr>
<tr>
<td>Delete Unit</td>
<td>Do not delete anyone’s home unit! (Otherwise the proposal will not be routed to their dept for approval, and your ORPA rep will reject your proposals and you will have to add the person’s home unit back to the person and submit again). Only use this if you accidentally add the wrong lead unit number here.</td>
</tr>
<tr>
<td>Find Unit</td>
<td>Use this button to find and add a unit for a center or program.</td>
</tr>
</tbody>
</table>
How to add a Princeton Investigator

1. Press Find Person

Enter their name (or part of their name and a star)

Press Find

Select the person from the list. Click Ok.
How to add another Princeton Investigator

Click Find Person again and go through the steps as in the previous section, but you won’t have to add the lead unit again. Be sure to not remove anyone’s home unit.

How to add a non-Princeton Person

Only add non-Princeton people if:

1. It’s a person who is coming to Princeton University and is applying for funding as if they are here but they are not yet in the Princeton person search (i.e. they cannot be found using the “Find Person” button).
2. It’s an s2s proposal and the person must appear on the Senior/Key Person form.

Otherwise, do not add non-Princeton people.
If the person’s name is not in the search results list, you’ll have to add them to the Rolodex first. Please see the Rolodex section of the manual.
FYI: Personnel Names, PS primary name and PS preferred name

On 4/16/09, the personnel names in all Coeus modules were updated to not include special characters (i.e. removing accents from characters). This makes searching for personnel names easier in all modules, and also helps with system-to-system Coeus to Grants.gov connection, since special characters cause submission issues for Grants.gov. However, at that time, the PeopleSoft primary name was pulled in instead of the PeopleSoft Preferred name. As of 5/14/09, the Preferred PeopleSoft name without special characters is being used.

If you know of a PI in your department whose Coeus Personnel name (PeopleSoft Preferred name) differs from his or her eRA Commons name, please let the Coeus coordinator know immediately.

A note about inactive people

As of 3/28/12, a new rule was added to Coeus production. This validation rule checks to see if anyone on the Investigator or Key Person tab has inactive status at Princeton.

If you try to submit a proposal with an inactive person on the investigator or key person tab, you will see this error message:
A person on the Investigator or Key Person tab is inactive.
Please remove the inactive person and coordinate with your ORPA administrator.

You will then need to do what it says (contact your ORPA administrator) to continue.
Certifying investigators

Press the Certify button

Answer yes or no. Click OK
BUG ALERT: You press the Certify button on the Investigator tab but Coeus tells you “This is not a proposal person”. This intermittently happens without reason. The workaround is to remove the person from the investigator tab, press save, add the person back. Then you should be able to certify the person.

Click on the next row and click on Certify to certify the next investigator. Repeat until all investigators have been certified.

After all investigators have been certified and the save button has been pressed, green checkmarks will appear for each person.
Printing the certification form through Coeus

If you have green checkmarks for everyone, click on the Action menu. Select Print Certifications.

Press "Print All"

NOTE: The certification form can only be printed if the certification question in Coeus has been answered.
Printing the Certification Form through the Coeus home page

Printing the cert form through Coeus is a bit of a chicken and egg situation. You can't print the form for the investigator to sign until you certify the investigator for conflict of interest, but you might not know if there is a conflict of interest until the investigator signs the form.

You can either answer No on the Coeus search screen, print the form through Coeus, then change it to Yes on the Coeus cert screen if the investigator checks off yes on the form, or you can just print the form from the Coeus home page and then answer the cert question in Coeus (and not print the form at all through Coeus).

The Adobe fillable version of the PI cert form is on the Coeus Forms page at http://www.princeton.edu/orpa/coeus/coeus-forms/.

The Key Person Tab

Orange: Fill in only if applicable to your proposal

Pink: s2s only
The Key Person tab lists key people on the proposal who appear on the application submitted to the sponsor.

- For federal proposals, only include on this tab key people who are listed on the senior/key person form.
- Do not list non-Princeton people on this tab unless the proposal is submitted via s2s; see the s2s guide.
- Do not list TBA people on this tab.
- Do not list the same person on both the Investigator and the Key Person tab. It's one tab or the other, not both.

How to add a Princeton Key Person
The steps are the same as for adding a Princeton Investigator except the person is added on the Key Person tab; please see prior section.

How to add a non-Princeton Key Person
The steps are the same as for adding a non-Princeton Investigator; please see prior section.

How to add the Unit
When you initially add a Princeton or non-Princeton person to the Key Person tab, no unit information will be displayed at the bottom.

- If the unit the person is associated with is already on the Investigator tab, there is no need to add the unit information here.
- If the unit the person is associated with is not already on the Investigator tab, click on “Add Unit” and then enter the unit number in the Unit Number box; click or tab out and Coeus will automatically fill in the unit name.

A note about inactive people
As of 3/28/12, a new rule was added to Coeus production. This validation rule checks to see if anyone on the Investigator or Key Person tab has inactive status at Princeton.

If you try to submit a proposal with an inactive person on the investigator or key person tab, you will see this error message:
A person on the Investigator or Key Person tab is inactive.
Please remove the inactive person and coordinate with your ORPA administrator.

You will then need to do what it says (contact your ORPA administrator) to continue.
The Special Review Tab

The special review tab is used to list research that requires the submission of a protocol and approval from the appropriate Research Integrity and Assurance (RIA) compliance committee at Princeton University. The PI must submit a protocol to the appropriate committee for any human subjects, animal research, recombinant DNA or biohazardous materials that are described in the proposal.

This tab is also used to record Export Control information for Equipment Export, Foreign Collaborators, Foreign Travel, and ITAR items.

<table>
<thead>
<tr>
<th>Special Review type</th>
<th>Oversight board</th>
<th>Abbr.</th>
<th>Contact address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human subjects</td>
<td>Institutional Review Board for Human Subjects</td>
<td>IRB</td>
<td><a href="mailto:irb@princeton.edu">irb@princeton.edu</a></td>
</tr>
<tr>
<td>Animal Usage</td>
<td>Institutional Animal Care and Use Committee</td>
<td>IACUC</td>
<td><a href="mailto:iacuc@princeton.edu">iacuc@princeton.edu</a></td>
</tr>
</tbody>
</table>

Orange: Fill in if applicable to your proposal.
Special Review: Export Control

Equipment Export, Foreign Collaborators, Foreign Travel, ITAR items

https://www.princeton.edu/orpa/compliance/export-controls/

John Jenkins, Export Control Officer
exports@princeton.edu
How to enter Special Review data

For IRB, IACUC, or IBC protocols: Select the Special Review type and Approval status.

If approved or exempt, enter the protocol number, application date and approval date.

If pending, protocol number and dates can be left blank.

For export controls, select the appropriate type.

Enter details about the export control in the Comments box.

Leave other boxes blank.

<table>
<thead>
<tr>
<th>Approval status</th>
<th>When to use this status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>Only when the protocol has been approved by the appropriate RIA committee. The PI has received an official approval letter from the committee.</td>
</tr>
<tr>
<td>Exempt</td>
<td>Only when the protocol has been declared exempt by the appropriate RIA committee. The PI has received an official exemption letter from the committee.</td>
</tr>
<tr>
<td>Pending</td>
<td>The PI has submitted a protocol to the appropriate RIA committee, but protocol approval has not been granted, or the PI has not yet applied for approval.</td>
</tr>
<tr>
<td>DO NOT USE - Not yet applied</td>
<td>This status is no longer used. Do not select this status.</td>
</tr>
<tr>
<td>Blank</td>
<td>Only leave approval type blank for Export Control items. If it’s a RIA protocol, select one of the approval statuses above.</td>
</tr>
</tbody>
</table>
Tip! If you accidentally add a blank row (in any Coeus tab), and try to save, Coeus says you need to fill in that row.

If you don't need the blank row, click on that blank row (so the hand/claw points to it) and press Delete. Then you will be able to save.

Tip! If you accidentally add a blank row that you do not need, highlight the row and click on the [Delete] button on the right side of the panel. Coeus will not allow you to save if there is a blank row on the Special Review panel.

Congruency Reviews and the Special Review tab

Since 9/15/13, the IACUC and IBC offices have conducted a pilot program involving congruency reviews for new federal and non-federal awards involving animal research, biohazardous materials or recombinant DNA.

Congruency review means that the animal, biohazardous material and/or recombinant DNA research described in the proposal matches the animal, biohazardous material and/or recombinant DNA research described in the protocol.

The pilot process is as follows:

1. Sponsor notifies ORPA that proposal has been awarded.
2. ORPA sees the award has animal and/or biohazardous research.
3. ORPA notifies dept that award is here and has animal and/or biohazardous research.
4. Dept works with appropriate office(s) within RIA to obtain the compliance congruency letter(s). This includes the appropriate office(s) within RIA sending the congruency letter(s) back to the dept.
5. Dept then copies the original Coeus Proposal Development proposal, changes proposal type to Preaward Revision, and adds updated compliance info on the special review tab if necessary. Dept also uploads the congruency letters into the appropriate Coeus narrative type. Multiples of each type can be selected if there are multiple protocols on a proposal:
   a. IACUC Congruency
   b. IBC Congruency
5. Dept submits the copied proposal as a Preaward Revision for approval.
7. After dept approves, the GCA in ORPA then reviews the proposal, checks for current protocol dates and the congruency letters in the narrative section, and approves. GCA then enters the Institute Proposal number upon approving to link the original Proposal Development proposal and the resubmitted Proposal Development proposal to one Institute Proposal number.

8. The GCA would then ask the award specialist to setup the award.

Please only attach congruency letters that you receive from the IACUC and IBC office. Emails or other forms of documentation are not acceptable.

The process for congruency review for subawards with compliance research; existing active awards; and incremental funding, is still to be worked out.

If you have IACUC/IBC questions, please contact IACUC@princeton.edu or IBC@princeton.edu.
The Science Code Tab

The Science Code Tab is not used at Princeton; skip it!

The Other Tab

The Other Tab is used to capture the PS Award ID for a renewal of an existing award, a supplement to an existing award, or a revision of an existing award.

Type the 10 digit PS Award Number into the PS Award No box if this proposal is a renewal of an existing award, a supplement to an existing award, or a revision of an existing award.

Saving the Proposal: save frequently!

Click Save frequently! Coeus does not automatically save most items, so be sure to press save often!!!
Proposal Budget

Enter the proposal budget into the Coeus budget module.
- Coeus will automatically calculate inflation and salary increases as well as overhead.
- Budgets can be copied into multiple budget versions, or you can start new versions from scratch.
- You can create as many budget versions as needed, then mark one of them as final and complete for submission.
- If you have a pre-proposal that does not have a budget, mark the $0 budget as final and complete (otherwise Coeus will not let you submit).

Coeus Budget Process Overview

Create a new budget
- Select OH and UR rate types on summary tab
- Set up and verify rates (sync budget rates if proposal was copied)
- Adjust period boundaries if needed

Add details for 1st period
- Add details for first budget period
- Personnel line items
- Non-personnel line items

Generate budget periods
- Inflation will be applied automatically for most cost elements

Adjust budget as necessary
- Delete or add line items
- Modify costs

Other
- If cost sharing is included in this budget, distribute the cost sharing
- Print budget reports if desired

Finalize budget
- Select a budget version and mark that budget as final and complete.
**Budget Primer**

What do you need to enter a budget in Coeus?

A budget

- Needs to be specific
- Needs to match Coeus cost elements
- “Misc” is not specific!
- Typically provided by PI
- or PI may ask you to create the budget

What are Direct Costs?

Direct costs are items that can be directly charged to the grant, including:

- Salaries & wages
- Benefits
- Consultants
- Travel
- Equipment
- Materials & Supplies
- Subrecipients

What are Indirect Costs?

As per Module 3 of the ORPA Sponsored Research Training for Dept Admins, indirect costs are items that “include those things essential to support sponsored activities that cannot be specifically identified and directly charged or attributable to a particular research grant or contract”. Examples include heating and cooling the building where the research is done and building maintenance, among other items. [This link](#) on the F&T website includes more information about the Indirect Cost rate.

Indirect costs have a few names and abbreviations; they all mean the same thing:

- Indirect Costs (IDC)
- Overhead (OH)
- Facilities & Administration (F&A)

What is Princeton’s Indirect Cost rate?

- 62% On campus
- 26% Off campus
- Sponsor may pay some other percentage
- Sponsor might not pay any OH (0%)
The indirect cost rate typically remains the same for several years.

**What do MTDC & TDC mean?**

- MTDC stands for Modified Total Direct Costs
- Some items are excluded from OH base calculation
  - i.e. tuition, equipment over $5k, subcontract amounts over the first $25k are excluded from the OH base calculation.
- TDC: Total Direct Cost
  - OH is calculated on every cost element, including tuition and equipment over $5k.

**What about Employee Benefits?**

Most personnel items have benefits and are known by a few different names and abbreviations; they mean the same thing:

- Employee Benefits (EB)
- Fringe Benefits ("the fringe")

The EB rate changes every year; see the ORPA Rate Sheet for the current year’s rate and the project rate.

[This link](#) on the F&T website includes more information about the EB rate.

**Starting the Budget**

![Image of the F&T website showing a proposal with a yellow money bag and a message: To start a budget, click on the yellow money bag.](#)
The Budget Persons window opens with 12M Duration selected for everyone on the Investigator and Key Person tabs. You can update the appointment types now or later. (PIs are typically 9M Duration). The Job Code is from PS HCM and can be ignored here. Click OK (if Close is clicked, the people on this screen will not be listed in the Red Running Guy. So it's better to click OK.)
The budget summary tab displays budget cost information, is where the OH rate type is selected, and is where budgets are marked as Final and Complete before submission.

Before starting your budget, the most important things to verify are the start/end dates are correct and # of months are correct:

- If the dates are wrong, close the budget screen (do not save), update the dates on the Proposal tab, and start a new budget.
- If the # of months should not be 12 months per period, see the "Adjusting Period Boundaries" section.
# What every box on the budget summary tab means

<table>
<thead>
<tr>
<th>Summary Tab Field</th>
<th>What it means/how to fill it in</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version</strong></td>
<td>There’s always at least one budget version. You can create as many budget versions as you’d like.</td>
</tr>
</tbody>
</table>
| **Final checkbox**    | Check this box for your Final budget.  
  - A budget must be marked final before the budget can be marked Complete.  
  - A budget must be marked final in order to print generic Coeus forms like the generic Cover Page.                                                                 |
| **Start & End Dates** | Taken from the Proposal tab. If the date is wrong, do not change it here! Instead, close the budget (with the yellow folder icon in the second toolbar), change the start date on the Proposal tab, and then return to the budget. |
| **Residual Funds**    | This box is for a renewal of an existing award to specify the amount of funding left over. Generally not used.                                                                                                                   |
| **Total Cost Limit**  | If you want to set a cost limit for the entire proposal and be warned when the budget exceeds the limit, fill in an amount here.                                                                                               |
| **OH Rate Type**      | The Overhead Rate type. Default is our standard 62% OH rate.                                                                                                                                                                 |
| **Total Cost**        | Automatically calculates as you fill in the budget period screens and save. This is the total cost to the sponsor and does not include cost sharing.                                                                           |
| **Total Direct Cost Limit** | If you want to set a direct cost limit for the entire proposal and be warned when the budget exceeds the limit, fill in an amount here.                                                                                     |
| **Direct Cost**       | Automatically calculates as you fill in the budget period screens and save. This is the total direct cost to the sponsor and does not include cost sharing.                                                                    |
| **Indirect Cost**     | Automatically calculates as you fill in the budget period screens and save. This is the total indirect cost to the sponsor and does not include cost sharing.                                                                      |
| **Underrecovery**     | The difference between Princeton’s standard 62% rate and the rate the sponsor is paying. Other schools make their professors come up with this difference but Princeton does not.  
  - You cannot submit a proposal with positive underrecovery. To avoid positive underrecovery:  
    - Make sure the UR Rate Type is the same as the OH Rate Type  
    - Do not uncheck the OH box on the Line Item Detail screen  
  - Negative underrecovery is a Coeus quirk and can be ignored.                                                                                                           |
| **Cost Sharing**      | Automatically calculates as you fill in the budget period screens and save. This includes directs and indirects, even when indirects are not allowed by the sponsor.                                                              |
| **Comments**          | Great way to discuss tricky situations or add notes to distinguish budget versions.                                                                                                                                           |
| **Budget Status**     | Default is Incomplete. Change it to Complete when you are finished entering budget details. You can always mark it incomplete again to make more changes before submission.                                                |
| **UR Rate Type**      | The Underrecovery Rate Type. Always make sure the UR Rate Type matches the OH Rate Type.                                                                                                                                       |
| **On/Off Campus**     | Leave it as “Default”                                                                                                                                                                                                            |
| **Modular Budget**    | Only check this box if your proposal is an NIH Modular Budget that will be submitted via s2s.                                                                                                                                  |
| **Submit Cost Sharing** | Always leave this box checked.                                                                                                                                         |
| **Proposal hierarchy**| Indicates if the proposal is in a hierarchy or not.  
  - Red X: not in a hierarchy  
  - + sign: parent of the hierarchy  
  - - sign: child of the hierarchy                                                                                                                                       |
| **Info at bottom of screen** | Summarizes start/end dates, # of months, and costs by budget period.                                                                                                      |
• # of months defaults to 12 per period. To change the number of months per period, see the “Adjust Period Boundaries” section.
• Costs automatically calculate as data is entered in each period and save is pressed.

**Entering Personnel Items: Overview**

**Personnel cost elements**

<table>
<thead>
<tr>
<th>Personnel want to budget...</th>
<th>Use this Budget Item...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faculty</td>
<td>SALRF – Regular Faculty</td>
</tr>
<tr>
<td>Grad Students</td>
<td>SALGS – Assistants in Research and Instruction</td>
</tr>
<tr>
<td>Post-docs (not s2s)</td>
<td>SALOS – Salary DOF Other Staffs</td>
</tr>
<tr>
<td>Post-docs (s2s)</td>
<td>202PDOC – s2s only after 7/1/14: Postdoctoral Associate</td>
</tr>
<tr>
<td>Undergrads</td>
<td>WAGESH – Student Hourly Wages</td>
</tr>
<tr>
<td>Admin or Tech staff (only if sponsor allows it)</td>
<td>SALADM – Salary HR Admin &amp; Tech</td>
</tr>
<tr>
<td>Biweekly staff (only if sponsor allows it)</td>
<td>SALBW – Salary HR Bi-Weekly.</td>
</tr>
</tbody>
</table>

**Methods for entering personnel items:**

1. Running Guy/ Red Baron method: The cost is calculated for you based on data you enter in the
   - Running Guy and Red Baron for the person’s:
     • Base salary
     • Number of months
     • Percent charged/effort

2. Manual method: Or, you can manually enter the sponsor’s cost directly on line item

In the first method, Coeus is calculating the cost for you. In the second method, you are calculating the cost outside of Coeus and then entering that value into the Coeus budget. If you are going to do s2s proposals, then you have to learn the first method. If you are never going to do s2s or your budget is an NIH s2s modular budget, then you can enter your costs using the second method.

Some users use the red baron for every proposal they submit regardless of sponsor and submission method, and others never use it.

**Entering Personnel Items using The Running Guy and The Red Baron**

**Personnel**

In this example, let’s enter Faculty Salary for 2 summer months for the PI.
Appt Type: Typically 9 months for Pls. Fill in the Calc Base manually. The Calc Base is the salary as of the Eff Date. In this example, $90k divided by 9 = $10k per month. Einstein and Curie are our Pls and Debbie Fields is a Key Person. Click OK.

1. Click on the Period 1 tab.
2. Click on the Add button (In the second toolbar, it's the first button).
Double click in the Cost Element (CE) box for that row.

Select the cost element & click OK.

With the row highlighted, click on the Red Baron.
Click Add.

Click on the person so their row is blue, then click on OK.
Let's budget 2 summer months of faculty salary.

Change start/end dates to appropriate dates (2 months for this example). Select the Period Type.

% Charged: What percentage of the time in the start/end dates is being charged to the project?
% Effort: What percentage of the time in the start/end dates will that person spend working on the project?

Click OK.

The Salary is $20,800, not $20k, because Coeus automatically inflates most cost elements at 4% every 7/1. 4% of $10k a month is $400 times 2 months is $800.

After click OK, this row returns.
Quantity and Cost and are filled in.
Manually enter a description for the line item. It helps you and your ORPA rep.
If you need to change the cost, you have to use the red baron and/or red running guy.
You can't click into the Cost box and directly change the amount because you used the Red Baron.
TBA Personnel (Grad student example)

You might not know every named person in your budget, for example, grad students or a person who will be hired only if the project is funded.

In the running guy, click "Find Person" to add a TBA.

It is tempting to click "Add TBA" but nothing is in that button.

Enter tba* in the Last Name box & Click Find.

A list of all TBA types appears. Hover your mouse over the divider between the columns and drag the divider over to see the full "names" of the TBA people.
Highlight the row for the TBA person you want, then click OK.

If the TBA type you want is not here, select the first row, TBA.

For this example, the grad student is working the full 12 months (10 academic months at $26,450 + 2 summer months at $8,000) for a total of $34,450. Click OK.

Add a blank row with the Add button in the second toolbar. Double click in the CE box for the new row. Select SALGS for the grad student salary. With the SALGS row highlighted, click on the Red Baron.
1. Click Add

2. Select the TBA Grad Student row.

3. Click OK

Since the Grad Student will work all 12 months, the start/end dates don't need to be updated.
Change Period to Calendar
Change % Charged and % Effort to 100%.

The salary is inflated every 7/1 by 3% for grad students (0% for undergrads, 4% for most everyone else) so the salary is more than the initial salary.

Click OK.
More than one TBA person of the same type

The Quantity and Cost are then returned. Type in the description for the Grad Student.

If you want to change the cost, you have to change the info in the red baron and/or red running guy. You can’t change the info in the cost column directly once you’ve used the red baron.

To add the second TBA person of the same type, click on the Red Running Guy

Click Find Person
Enter tba* and click Find.

Select the TBA person and click OK.

At this moment, Coeus thinks these two TBA people are the same person because they have the same name and the same job code.
Change the Job Code to be different.
Now Coeus thinks these are two different people.
Enter the Appt Type & Calc Base.
Click OK.

1. Add a new blank row.
2. Double click in the CE box for the new row and select SALGS.
3. Click on the Red Baron.

1. Click Add
2. Select the row for the TBA2 Grad Student
3. Click OK
2 month employee type (i.e. Undergrads)

Let’s say you have grad students who will only work the summer, or you have a summer undergraduate who only works 2 months. Finally there is a 2 month employee type. You can use this type in the red running guy and red baron.
Red Baron Troubleshooting Tips

If cost comes out as $0, or a value you didn’t expect, double check…

- Running guy
  - Appt type correct?
  - Eff date ok?
  - Base salary filled in?

- Red baron
  - Start and end dates correct?
  - % charged and % effort filled in?

- Don’t want cost sharing?
  - % charged has to be equal to % effort

- Want cost sharing?
  - % charged has to be less than % effort to generate cost sharing

- Press save! Sometimes pressing save resolves all issues.

Red Baron and no inflation

If you don’t want inflation to be applied and you’re using the red baron…

- Use the running guy as usual
- Add your blank line item
- Select cost element
- Double click on cost element description
- Uncheck the “Apply Inflation” box
- THEN go to the red baron and use red baron as usual
- Inflation will not be applied
Removing a Line Item where the Red Baron was used

1. Highlight the line item.
2. Click the Red Baron
1. Click Delete
2. Click Yes.

The row then disappears. Click OK.
Entering Half a Summer Month in the Red Baron
What if you want to budget half a summer month?
- Currently the monthly salary is $10k a month.
- With 7/1 there’s 4% inflation, salary is $10,400 a month.
- So, half a summer month is $5,200, right?
- Coeus is calculating a daily rate (not a monthly rate).
- For months with an odd number of days, like July:
  - $10,400 divided by 31 days = $335.48 per day
  - 7/1-7/15 is 15 days = $5032.26
  - 7/1-7/16 is 16 days = $5367.74
- So if you want $10,400 divided in half as $5200….

Fill in 1 month.
50% Charged
50% Effort

Now it's exactly $5,200
Adding post-docs to the budget

As per Princeton's policy, up to 97% of a post-doc salary can be charged to a grant. Here is how you would enter that data in Coeus using the red baron. In the red running guy, the Calc Base is the post-doc's full salary.

In the Personnel Budget Details window, the %Charged and %Effort can both be up to 97%. By having the %Charged and %Effort values the same, cost sharing will not be generated. The salary amount is then 97% of the full salary, with 4% inflation as of 7/1).

NOTE: For s2s proposals, use 202PDOC; otherwise use SALOS.
Entering Personnel Items manually

Click Add button

Double click in CE box.

Click on the cost element so the row is blue, then click on OK.
Why use the red baron for personnel? Why enter the personnel cost directly on the line item?

**Why use the red baron?**

- You are using Coeus's ability to calculate cost based on the person's salary, number of months, % charged and % effort.
- You're submitting a detailed budget via s2s

**Why enter the personnel cost directly on the line item?**

- You already calculated the cost to sponsor outside of Coeus and want to directly enter the cost directly on the line
- You're submitting a NIH modular budget via s2s
- You're not submitting via s2s

*How Coeus calculates personnel salary and employee benefits*

**Budgets that start on the 1st of the month and end on the last day of a month using the red baron**

For this example, the budget period 1 is 12 months. It starts 11/1/16 and ends 10/31/17.

Let's say a person's salary is $120,000 a year as of 7/1/16. The person has a 12 month appointment. Coeus divides by 12 to get the monthly rate of $10,000 a month for Nov and Dec 2016 and Jan through June of 2017.
Starting with July 1, 2017, Coeus then applies the inflation rate in the rate table (currently 4%). It takes $10,000 times 1.04 to get $10,400 as the monthly rate for July, Aug, Sept, and Oct 2017.

So that's $10,000 for 8 months (Nov 2016 through June 2017) = $80,000

And $10,400 for 4 months (July 2017-Oct 2017) = $41,600

For a total of $121,600 for budget period 1.

**Budgets that do not begin and/or end on the 1st and/or last day of the month using the red baron.**

Let’s say you want to verify the Coeus calculations are correct. If your budget doesn’t start on the first of the month or end on the last day of the month, you will have to calculate the daily salary rate and multiply by the number of days in that budget period for that month, and then do the calculations for the remaining months.

Here’s how the calculation is done. Let’s say the budget is from 10/16/16-9/30/17. The budget period starts in a month that has 31 days. The budget period ends on the last day of the month.

Let’s say a person’s salary is $120,000 a year as of 7/1/16. The person has a 12 month appointment. Coeus divides by 12 to get the monthly rate of $10,000 a month for Nov and Dec 2016 and Jan through June of 2017.

At this point, to determine the Oct 2016 salary, it is tempting to take the $10,000 monthly salary and divide by 2 to calculate half a month’s salary, which would be $5000, but that’s incorrect. Half of the month of October would be 15.5 days. Coeus counts the actual dates for the budget period, which are full days. Oct 16 to Oct 31 is 16 days of salary, not 15.5.

For October 2016, it calculates a daily rate (so $10,000 divided by 31 = $322.58064 per day (don’t round to $322.58 at this point…)). The number of days from 10/16/16 to 10/31/16 is 16 days. Take the $322.58064 unrounded daily rate and multiply by 16 to get the value for Oct, which is $5161.29—more than the $5000 that was initially assumed in the example.

Starting with July 1, 2017, Coeus then applies the inflation rate in the rate table (currently 4%). It takes $10,000 times 1.04 to get $10,400 as the monthly rate for July, Aug, and Sept, which are all full months.

So that’s $5161.28 for Oct 16-31, 2016.

And that’s $10,000 a month for 8 months (Nov 2016 through June 2017) = $80,000

And $10,400 a month (with the 4% inflation) for 3 months (July 2017-Sept 2017) = $31,200

Add those figures together for a total of $116,361.29 for the entire budget period of Oct 16, 2016 to Sept 30, 2017. (If you had rounded the daily rate to $322.58, then your calculations would be a penny less at this point, at $116,361.28).

A similar calculation would occur if the budget started on the first of the month, and ended on, say the 15th of the month. To calculate the portion of the final month, take the monthly rate, divide it by the number of days in the month to calculate the daily rate, and then multiply by 15 to get the total amount for that month.

**Figuring out employee benefits for budgets that start on the 1st of the month and end on the last day of a month, not using the red baron**

Let’s say you enter the budget amount directly on the line item itself, and the amount is $2250.
It doesn't matter when the start or end date of the budget period is, Coeus will calculate a daily rate. So if it's not a leap year, divide by 365 to get the daily rate (in this case $6.16 per day).

Let's say the budget starts 6/1, so the benefit rate changes 7/1. $6.16 a day times 30 days for the month of June is $184.93. For FY 2016, the EB rate is 34.8%. That comes out to $64.36. Then for the other 11 months, the provisional EB rate is 34.0%. So $6.16 a day times 335 days is $2,065.07, times the 34.0% rate is $702.12. The grand total for EB in the first year of this budget for this line item is $766.48.

**Adding non-Personnel Items**

**Adding most non-personnel items**
Adding Human Subjects Payments and Adding Animal Supplies costs

- Human subject payments:
  - ☐ PRFSVC Professional Services should be used for human subject payments
- Animal Research Costs:
  - ☐ If there is a good understanding of how much will be incurred through the Princeton Lab Animal Resource (LAR) lab, use RECHOH Recharge Centers; otherwise, use SMSUP Scientific & Medical Supplies for animal research costs.

Adding Tuition

- Use AIARTU for grad student tuition
- Half tuition is charged if sponsor is paying the 62% OH rate
- Full tuition is charged if the sponsor is not paying the 62% OH rate
• Current Rate is on the ORPA Rate Sheet on the ORPA home page.

Subawards
• Princeton collects OH on first $25k of a sub
• Princeton does not collect OH on the remainder of a sub

Period 1:
Use SUBL25 for the first $25k of a subaward.
Use SUBG25 for the remainder.

Here, the sub to Harvard is $40k.
SUBL25 is $25k
SUBG25 is $15k (the remainder).

Enter the full sub amt in SUBG25 in subsequent years, since Princeton will already have collected OH on the first $25k in year 1.
Enter the full sub amt in SUBG25 in subsequent years, since Princeton will already have collected OH on the first $25k in year 1.

More than one sub

Add two lines, one for each subaward. Enter the sub’s institution in the Description.

Use SUBL25 for the first $25k.
Use SUBG25 for the remainder.
Generating periods, adding more line items, deleting line items, etc

Other Options

<table>
<thead>
<tr>
<th>Line</th>
<th>CE</th>
<th>Cost Element Description</th>
<th>Description</th>
<th>Quanity</th>
<th>Cost</th>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SALRF</td>
<td>Salary - Regular Faculty</td>
<td>PI 2 months summer salary</td>
<td>1.00</td>
<td>$20,000.00</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
<tr>
<td>2</td>
<td>DOMTRV</td>
<td>Domestic Travel</td>
<td>PI to attend annual conference</td>
<td>0.00</td>
<td>$5,200.00</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
<tr>
<td>3</td>
<td>INTTRV</td>
<td>International Travel</td>
<td>PI to attend conference in Italy</td>
<td>0.00</td>
<td>$7,280.00</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
<tr>
<td>4</td>
<td>AJARTU</td>
<td>Assistantship A/JAR Tuition</td>
<td></td>
<td>1.00</td>
<td>$26,734.46</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
<tr>
<td>5</td>
<td>SMSUP</td>
<td>Scientific &amp; Medical Supplies</td>
<td>I added this line AFTER generating.</td>
<td>0.00</td>
<td>$1,283.94</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
<tr>
<td>6</td>
<td>SUBG25</td>
<td>Sub-Contracts over $25k</td>
<td>Harvard</td>
<td>0.00</td>
<td>$40,000.00</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
<tr>
<td>7</td>
<td>SUBG25</td>
<td>Sub-Contracts over $25k</td>
<td>Yale</td>
<td>0.00</td>
<td>$75,000.00</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
<tr>
<td>8</td>
<td>SUBG25</td>
<td>Sub-Contracts over $25k</td>
<td>Rutgers</td>
<td>0.00</td>
<td>$100,000.00</td>
<td>01-Dec-2017</td>
<td>30-Nov-2018</td>
</tr>
</tbody>
</table>

Enter the full sub amt in SUBG25 in subsequent years, because Princeton will already have collected OH on the first $25k.
Line Item Detail box—unchecking “apply inflation” or changing the campus type from On to Off
Generate Periods

Once you’ve filled in all line items that will be entered into period 1, now you can use the Generate Periods button to generate the remaining budget periods.

Note that once periods are generated, they cannot be generated again.

Viewing Generated Periods

Click on the period 2, 3, etc tabs to view the new periods.
The Total Tab

The total tab shows the total by cost element and period as well as the grand total.

Delete Line Item

1. Select line item to be deleted.

2. Press the delete button
Adding a line item to all periods after generating

The line item disappears. Repeat as necessary for each line and/or period.

In period 1, add the line item and enter the description, quantity (if applicable) and cost.

2. From the Items menu, select "Apply to later periods"
The line is added to each period thereafter.
Viewing EB and OH for line items, viewing which lines are On or Off campus, or have underrecovery

To show EB and OH for each line item, or to add columns to view On/Off campus lines, cost shared lines or lines with underrecovery, click on the Wrench button in the second toolbar.
Check off the items you want to see.

"Show Calculated Amounts" will show the OH and EB for the highlighted item at the bottom of the screen.

Checking the other boxes will add columns to the display. You can uncheck items you don't want to see, then click OK.
If "Show Calculated Amounts" was checked, then the bottom of the screen will show OH and EB for the highlighted row.

If you checked off other boxes, move the scroll bar to the right.
New columns will appear for the boxes you checked off. If you need more space, you can uncheck the start/end date boxes in the wrench button, or can manually move the column dividers over on this screen. However, once you click into another period or close and reopen the budget, the default view resets itself.
Changing OH, EB, Inflation Rates

OH rate is 0%

Each time you change a OH or UR Rate Type, you'll get this message:

- You will have to click "Yes" twice to this message for OH Rate Type and twice to this message for UR Rate Type.

OH rate is 10%

Select the OH and UR rate type as appropriate, either:
- MTDC – 10%
- TDC – 10%
- Most likely it’s “TDC -10%”
**OH rate is some other percentage**

In this example, the sponsor’s OH rate is 17.2% and the base is TDC.

---

**Select OH Rate Type and UR Rate Type as "TDC - Custom"**

---
Click on the Rates button in the second toolbar.

It’s very tempting to change the rates in the MTDC (or TDC) section, but scroll down to change it in the "TDC - Custom".

The default rate is 0%.
Then press Save.

**Negative underrecovery**

Negative underrecovery is generated every time you use the “MTDC-custom” or “TDC-custom" OH and UR Rate Types.
How to avoid positive underrecovery

- Change OH rate in proper section of rates table.
- Make sure your OH and UR rate types are the same!
- Do not uncheck the Apply box in Budget – Line Item Detail box

Change employee benefit rate

When sponsor pays a different EB rate than Princeton’s rate
Change inflation

Coeus automatically inflates as follows:

- 4% for most items
- 3% for grad student stipends
- 0% for undergrads

Scroll to the Employee Benefits Research Rate section. Change the rate. Press OK.

Do not press Reset or Sync as it will change the rate back.
Syncing Rates

Each year the Princeton Employee Benefit rate is renegotiated with the federal government.

The rates are not changed in Coeus until the University Treasurer signs the new rate agreement and the agreement has been posted on the F&T website.

Please don’t use the new rates in proposals until the rates have been officially updated in Coeus because the new rates are not legally binding until the agreement has been fully executed.

If you’re working on a proposal and ORPA sends the notification stated the employee benefit rate has been updated in Coeus, you have two options on how to update the rates for your proposal:

1. If your OH rate is MTDC or TDC, and you have not changed inflation rates, you can click on the rates button (% sign in the second toolbar in your budget) and click sync, click ok, and then save. This will then calculate using the new EB rate.
2. If your OH rate is “MTDC- custom” or “TDC – custom”, or you changed the inflation rate, then click on the rates button, scroll to the EB section and manually change the rates for every row and every fiscal year. Don’t press sync! (If you press sync, your custom OH rates will be reset back to 0 and inflation rates will be reset back to the defaults; you’ll have to change those rates all over again.)
Cost Limits

Direct cost limits—great for NIH modular budgets

1. Enter the Direct Cost limit
2. Highlight the row where you want Coeus to "do the math" so the total direct cost comes up to your direct cost limit.

3. From the Items menu, select "Sync to Direct Cost Limit"

Press Sync. It syncs ALL values (EB, OH, inflation) in this table to current values.
Note: When you press the save button, Coeus will warn you if you’ve exceeded your Direct Cost Limit.

**Total cost limits**

Coeus "does the math" for you and adjusts your line item up or down to match the direct cost limit. Great for NIH Modular Budgets, which have direct cost increments (or modules) of $25k.

1. Enter the Cost Limit.
2. Highlight the row where you want Coeus to "do the math" for you.
3. Select "Sync to Period Cost Limit"
Note: When you press the save button, Coeus will warn you when you’ve exceeded your Total Cost Limit.
Printing

Printing inside the budget

While in the budget screen, from the File menu, click Budget Summary.

You can select more than one report to print at one time if you want.

Ignore the "Print Budget Comments" box. Even if you check off that box, the budget comments will not print.

Industrial budgets print the budget item's direct cost, indirect cost, and benefits as one amount.
Printing outside of the budget

Close the budget.
1. Select the report you want to print.

2. Press print.

NOTE: A budget must be marked as final in order for these cost sharing reports to print.
Princeton University
Cost Share Report

Sponsor: National Science Foundation
Principal Investigator: Cava, Robert
Project Period: From 12/01/2016 to 11/30/2019
Total Project Amount: $602,513
Total Cost Share: $10,548
Proposal #: 00018454
Title: Kyle demo 10/20/14

The report prints in a tab in your browser window. You can save, view or print it.

PU_CostShareReport shows cost sharing by unit and amount per year.

<table>
<thead>
<tr>
<th>PROJECT YEAR</th>
<th>UNIT/PG NUMBER</th>
<th>UNIT NAME</th>
<th>COST SHARE AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017</td>
<td>23500</td>
<td>CHM-Chemistry</td>
<td>$3,000</td>
</tr>
<tr>
<td></td>
<td>54002</td>
<td>General Funds Inc Coll</td>
<td>$1,850</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$4,850</td>
</tr>
<tr>
<td>2018</td>
<td>23500</td>
<td>CHM-Chemistry</td>
<td>$3,000</td>
</tr>
<tr>
<td></td>
<td>54002</td>
<td>General Funds Inc Coll</td>
<td>$1,850</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$4,850</td>
</tr>
<tr>
<td>2019</td>
<td>23500</td>
<td>CHM-Chemistry</td>
<td>$3,000</td>
</tr>
<tr>
<td></td>
<td>54002</td>
<td>General Funds Inc Coll</td>
<td>$1,850</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$4,850</td>
</tr>
</tbody>
</table>

Total Cost Share: $10,548

Princeton University
Cost Share Report

Sponsor: National Science Foundation
Principal Investigator: Cava, Robert
Project Period: From 12/01/2016 to 11/30/2019
Total Project Amount: $602,513
Total Cost Share: $10,548
Proposal #: 00018454

PU_CostShareDetailsReport shows cumulative cost sharing by unit, amount, and type

Contributing Unit
23500CHM-Chemistry $9,000
54002General Funds Inc Coll $5,580

Type
International Travel $9,000
F & A $1,548
Princeton University
Chocolate Chip Cookies are GREAT!

Principal Investigator
Robert J Cava

Co-Principal Investigator

Presented to
Cookie University
Debbie Freda
123 Cookie Boulevard

Cookston, PA 22230

Project Period
10/01/2012 to 09/30/2015

Total Project Amount
$639,700

Principal Investigator
Robert J Cava
Chemistry
116A Fick Chemistry Laboratory
Princeton, NJ 08544
rcava@princeton.edu
609.258.3906

Authorized Institution Official
Jeffrey Friedland
4 New South Building
PO Box 36
Princeton, NJ 08544-2020
awards@princeton.edu

P: 609-258-3090
F: 609-258-1159

Business Contact
Jeffrey W Peniss
Office of Research and Project Administration
4 New South Building
Princeton, NJ 08544-0056
jpeniss@Princeton.EDU
P: 609258.6325
F: 609258.1159

A budget must be marked as final AND the mailing address must be filled in on the Mailing Info tab for the generic cover page to print.

Some depts print this page and others never print it.
Adding Budget Versions (new, copied)

Start another new budget from scratch
First, if the budget screen is open, close it. Then...

1. Click on the Money Bag
2. Click New
Select Appt Types if you will use the red baron; otherwise click OK.

Now you have a brand new budget version to work in.
Copying Budgets

NOTE: Copying pre-Prime proposals with budgets:

- All the old cost elements were used pre-Prime.
- Coeus will not let you submit a budget with the old cost elements.
- You will have to replace the old pre-Prime cost elements with the new Primed budget items in your copy.

First, if the budget screen is open, close it. Then…

[Instructions and screenshots showing the steps to copy a budget are included in the image.]
Marking Budget as Final and Complete

Marking budget as final

You can mark a budget as final at any time, even when you’ve just started a budget.
If you're on the budget Summary screen, check the Final box.

**Step 1:** Check the Final box.

**Step 2:** Then click Yes.

Then press Save.

---

From outside the budget screen, click on the Yellow Money Bag.

**Step 1:** Click on the Yellow Money Bag.

**Step 2:** Check the box for the version that should be Final.

**Step 3:** Click OK.
Marking the budget as complete

A budget must be marked Final first before it can be marked Complete. A budget must be marked Final and Complete before the proposal can be submitted for approval.
The budget is marked final & complete but I need to make changes & Coeus won’t let me make changes

NOTE: Once the budget is marked final and complete, the “New”, “Modify”, and “Copy” buttons are grayed out. To activate those buttons again, change the budget status to Incomplete and the buttons will illuminate. Then you can add a new budget, modify or copy an existing budget.
Non 12-month budget periods

Coeus defaults proposal periods to 12 months each.
If your proposal periods are different than 12 months, follow these steps before you start entering budget items.

Start a new budget. From the Budget Periods menu, select "Adjust Period Boundaries"
Start manually adjusting dates. In this example:
period 1 is 4 months
period 2 is 8 months
period 3 is 6 months

To add period 4, click Add...

...and fill in dates for period 4
Repeat until all periods are filled out, then click OK.

Verify the number of months for each period is right. If incorrect, go back to Budget Periods, Adjust Period Boundaries, and correct the dates BEFORE adding cost elements.
Changing Dates

If you're in the middle of your Coeus proposal and your PI decides to change the proposal dates, you must follow these steps in this order, otherwise it will not work:

1. Change Start and End Dates on the Proposal tab. Here I shifted the dates by a month.
2. Press Save.

Select budget you want to modify and click the Modify button.
Now review and tweak your budget. If you used the red baron, you will (probably) have a lot to fix.

For example, this was 7/1/17-8/31/17 but now Coeus advanced it 1 month, 8/1/17-10/1/17. You will have to manually change the dates to what they should be in the red baron.
No Budget

Sometimes, there’s no budget (i.e. many pre-proposals have no budget)

You will get the message (screenshot below) when trying to submit...

Mark your $0 budget final and complete, then you can submit.

Budget Tips & FYIs

Tip: Fast way to select cost elements

Type in cost elements (in all caps) instead of selecting from menu

Type CE in all capitals.

Click or tab out of CE field, and the description is filled in automatically.
FYI: Typing in cost box

<table>
<thead>
<tr>
<th>Line</th>
<th>CE</th>
<th>Cost Element Description</th>
<th>Description</th>
<th>Qnty</th>
<th>Cost</th>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DOMTRV</td>
<td>Domestic Travel</td>
<td></td>
<td>0.00</td>
<td>$10,000.00</td>
<td>01-Jan-2017</td>
<td>31-Dec-2017</td>
</tr>
<tr>
<td>2</td>
<td>INTTRV</td>
<td>International Travel</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>01-Jan-2017</td>
<td>31-Dec-2017</td>
</tr>
</tbody>
</table>

Type in Cost and press return...

...cursor is now in the CE box, not in the cost box

...so if you start typing in "cost" because you think you're in the cost box, it's actually appending to the CE box.
Then when you click or tab out of the CE box, you get this message.

Coeus then resets the CE box back to what it was. Now you can enter the cost in the Cost box.

FYI: Overwriting costs

The cost of this trip was initially $10k
Tip: Quantities

Entering a quantity doesn't always make sense

You don’t have to enter quantities (except for s2s with participant support costs)

Do not enter quantities over 99; Coeus can’t handle it!
### Tip: Adding blank rows

You can add a lot of blank rows to your budget.

Once you press save, any blank row without data (i.e. it’s still blank!) will be removed from your budget.

### Tip: Save frequently!

Please please please save your budget frequently. It is SO heartbreaking to spend an hour entering a HUGE budget and then Coeus tells you it can’t save your budget. Save frequently and that way, when Coeus doesn’t like something, you will know what it didn’t like (whatever it was you entered since your last save!)

### Coeus Cost Elements and Prime Budget Items Charts

Mapping of retired Coeus cost elements to new Prime budget items

<table>
<thead>
<tr>
<th>Old Cost Element</th>
<th>Description</th>
<th>New Prime Budget Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BPG201</td>
<td>Faculty Salary</td>
<td>SALRF</td>
<td>Salary - Faculty</td>
</tr>
<tr>
<td>BPG202</td>
<td>Professional research &amp; technical staff</td>
<td>SALOS</td>
<td>Salary - DOF Other Staffs</td>
</tr>
<tr>
<td>BPG204</td>
<td>Admin, other tech &amp; shop labor</td>
<td>SALADM</td>
<td>Salary - HR Admin</td>
</tr>
<tr>
<td>BPG207</td>
<td>Special Payroll</td>
<td>SALADM</td>
<td>Salary - HR Admin</td>
</tr>
<tr>
<td>BPG208</td>
<td>Student Wages Undergrads</td>
<td>WAGESH</td>
<td>Student Hourly Wages</td>
</tr>
<tr>
<td>BPG209</td>
<td>Assistants in Research Grads</td>
<td>SALGS</td>
<td>Salary - Asst in Res &amp; Instruc</td>
</tr>
<tr>
<td>BPG210</td>
<td>Purchased Labor/ Other Personnel</td>
<td>SALADM</td>
<td>HR Admin Salary</td>
</tr>
<tr>
<td>BPG211</td>
<td>Student Health Fee - no IDC</td>
<td>FELTUI</td>
<td>Fellowship Tuition</td>
</tr>
<tr>
<td>BPG212</td>
<td>Assistants in Research Tuition - no IDC</td>
<td>AIARTU</td>
<td>Assistantship AI/AR Tuition</td>
</tr>
<tr>
<td>BPG213</td>
<td>Fellowship Tuition - no IDC</td>
<td>FELTUI</td>
<td>Fellowship Tuition</td>
</tr>
<tr>
<td>BPG214</td>
<td>Fringe Benefits</td>
<td>FRINGE</td>
<td>Fringe Benefits</td>
</tr>
<tr>
<td>BPG216</td>
<td>Other Student Aid Support - no IDC</td>
<td>FELSTI</td>
<td>Fellowship Stipend</td>
</tr>
<tr>
<td>BPG220</td>
<td>Materials &amp; Services</td>
<td>SMSUP</td>
<td>Scientific &amp; Medical Supplies</td>
</tr>
<tr>
<td>BPG235</td>
<td>Rent, space, &amp; equipment</td>
<td>RENT</td>
<td>Rental Expense</td>
</tr>
<tr>
<td>BPG236</td>
<td>Subcontracts over $25k - no IDC</td>
<td>SUBG25</td>
<td>Sub-Contracts over $25k</td>
</tr>
<tr>
<td>BPG239</td>
<td>Subcontracts up to $25k</td>
<td>SUBL25</td>
<td>Sub-Contracts $25k and below</td>
</tr>
<tr>
<td>BPG250</td>
<td>Light &amp; Power - no IDC</td>
<td>UTIL</td>
<td>Utilities</td>
</tr>
<tr>
<td>BPG260</td>
<td>Departmental Charges Miscellaneous - no IDC</td>
<td>INSTAL</td>
<td>Institutional Allowance</td>
</tr>
<tr>
<td>BPG266</td>
<td>Computer - no IDC</td>
<td>COMPNO</td>
<td>Computer HW &amp; SW w/o OH</td>
</tr>
<tr>
<td>BPG275</td>
<td>Domestic Travel</td>
<td>DOMTRV</td>
<td>Domestic Travel</td>
</tr>
</tbody>
</table>
New Prime budget items

<table>
<thead>
<tr>
<th>Budget item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPOH</td>
<td>Computer HW &amp; SW w OH</td>
</tr>
<tr>
<td>FELSTI</td>
<td>Fellowship Stipend</td>
</tr>
<tr>
<td>OAGSUP</td>
<td>Office/General Supplies</td>
</tr>
<tr>
<td>PARTC</td>
<td>Participant Support (only if you’re not submitting via s2s—if you’re submitting via s2s use the appropriate specific pre-Prime s2s elements instead)</td>
</tr>
<tr>
<td>PRFSVC</td>
<td>Professional Services</td>
</tr>
<tr>
<td>RECHNO</td>
<td>Recharge Centers without F&amp;A</td>
</tr>
<tr>
<td>RECHOH</td>
<td>Recharge Centers with F&amp;A</td>
</tr>
<tr>
<td>SALBW</td>
<td>Salary - HR Bi-Weekly</td>
</tr>
<tr>
<td>TECSVC</td>
<td>Tech Services</td>
</tr>
</tbody>
</table>

Pre-Prime Coeus cost elements that remain in Coeus for s2s

If you’re submitting via s2s, use these pre-Prime cost elements | If you’re not submitting via s2s, use these new Prime budget items instead
---|---
202PDOC Post Doctoral Associate | SALOS Salary - DOF Other Staffs
220ODC Other Direct Costs | SMSUP Scientific & Medical Supplies
BPG205 Clerical Support | SALADM Salary – HR Admin
BPG230 Consultants & Other Fees | PRFSVC Professional Services
BPG233 Publications, reprints, pages | PRFSVC Professional Services
BPG261 Departmental Computing Equipment - no IDC | RECHNO Recharge Centers without F&A
BPG312 Departmental Computing OPER | RECHOH Recharge Centers with F&A
NIHSUB1 SUB1: Subaward Direct Costs: Total Sub Costs up to $25k (PUIDC calculates) | SUBL25 Sub-Contracts $25k and below
NIHSUB2 SUB2: Subaward Direct Costs: Total Sub Costs over $25k (No PUIDC calculates) | SUBG25 Sub-Contracts over $25k
NIHSUB3 SUB3: Subaward F&A: Total Sub Costs up to $25k (PUIDC calculates) | SUBL25 Sub-Contracts $25k and below
NIHSUB4 SUB4: Subaward F&A: Total Sub Costs over $25k (No PUIDC calculates) | SUBG25 Sub-Contracts over $25k
OTHERS Participant Costs / Other Costs - no IDC | PARTC Participant Support
STIPEND Participant Costs / Stipend - no IDC | PARTC Participant Support
SUBSISTE Participant Costs / Subsistence - no IDC | PARTC Participant Support
TRAVEL Participant Costs / Travel - no IDC | PARTC Participant Support
TUITION Participant Costs Tuition and Fees - no IDC | PARTC Participant Support

For the NIH Fellowship Form: Use AIARTU for tuition and FELSTI for stipend.

Revising budgets
There are three scenarios when you may need to revise a budget, such as either before or after a proposal has been awarded, or to move money from one cost element to another in project.

The three types of revised budgets are:

**Preaward Revision**: This Proposal Development proposal type should be used when the sponsor requests a revised budget *before* the proposal has been awarded.

**Revision of an Existing Award**: This Proposal Development proposal type should be used when the sponsor requests a revised budget *after* the proposal has been awarded and has been set up in PS Financials. For example, the sponsor has requested a revised budget for year 2 after already awarding year 1.

**Award Rebudget**: When money needs to be moved from one budget item to another in an already-awarded proposal that is already set up in PS Financials, but the total award amount remains the same and the sponsor approves of the rebudgeting. Fill out the ORPA OPAR and supporting Excel spreadsheet and send it to your GCA. Your GCA will review it and hand it off to the Award Specialist who will then update it in PS Financials.

### Preaward Revision

When a sponsor asks for a revised budget after your proposal has been submitted, but before it has been awarded and set up in PS Financials, you will need to copy the submitted proposal development proposal before you can revise the budget.

1. Copy the existing proposal.
2. Open the copy in edit mode and change the *Proposal Type* to *Preaward Revision*.
3. If the proposal dates have changed, change them on the Proposal tab first before opening the budget.
4. Open the budget and modify the budget. If the proposal dates have changed, update the dates on the Budget Summary tab and say yes to sync the rates. If you had to set custom rates, reset them now.
5. Preaward Revisions will go through the approval map just like a new proposal, but will not create a new Institute proposal. When ORPA approves the budget, your ORPA rep enters the existing IP number. That IP number will be updated by Coeus to contain a new sequence for the revised budget.

### Revision of an Existing Award

How to create and submit a Revision of an Existing Award:

- Start a new proposal.
- Select “Revision of an Existing Award” as the Proposal Type
- Enter the PS Award number for the existing award on the Other tab.
- The start and end dates for the proposal and the budget should be for the period of the budget that needs to be changed, not for the entire budget. For example, if the proposal is a 3 year budget and the sponsor is asking for a revised budget for year 2, the start and end dates should be for year 2 only.
- Enter the budget information for the years that need to be revised.
- Submit the proposal. The proposal will go directly to ORPA for approval and will not go through the departmental approval process again.
- When the ORPA rep approves the proposal, the Revision of an Existing Award will have a new Institute Proposal number.
Uploading Attachments (Narratives)

Upload all proposal files in the Narrative window. Examples of proposal files include the Narrative, Budget Justification, the sponsor's RFP, PI certification forms, and cost sharing commitment letters/forms (if applicable), among others.

It is recommended that PDF files only are uploaded, though Coeus will allow other file types such as Word docs and Excel files.

The proposal files should be final and complete before routing for approval.

If you are submitting via s2s, see the s2s guide for s2s-specific narrative information.

Uploading Narrative Files
Find the narrative file on your computer.
Click Open.

The file name populates. Click View to verify the correct file was uploaded, it was not truncated or corrupted, etc.
If you need to overwrite it, click Upload to find the right file.
Change status to Complete and click OK.

The Narrative row is displayed. Repeat to upload more narrative files.

Ignore User/Rights on this side of the screen.

This shows who uploaded the file, when it was uploaded, and what the name of the file is.
Changing status from Incomplete to Complete

If the file is still Incomplete status, highlight the row and click on the Edit button.

Change status to Complete and click OK.

Now it's complete.
Replacing/overwriting a narrative file

**Method #1**

1. One method for overwriting a file:
   - Highlight the row, then click on the Narrative Upload button.
   - Select the new file, then click Open.
   - Click on the icon to view the file to make sure it’s the right file, has not been corrupted or truncated, etc.

**Method #2**

The Other Method for Replacing a File:
- Highlight the row.
- Click the Edit button.

**Method #2 continued...**

Press the Upload button to find the file you want to upload. Then click OK.
Deleting a row

Highlight the row.  
Click the delete button. 
Coeus will ask you to confirm the deletion. 
Click Yes.

Moving Narrative rows...

If you want to, you can highlight a row and press the up or down arrows to reorder them.

You don't have to put them in any particular order, though.
Closing the Narrative window to return to the proposal tabs

Click the yellow folder icon to return to the Proposal tabs.

Overall

Press Close when you are done with this module.

You can:
--click on the icon for a row to view the file
--click on a row, then press the Edit button to edit status or overwrite a file
--can press the Upload Narrative button in the second toolbar to overwrite a file
--press the Eraser button in the second toolbar to remove a row
--use the aqua arrows in the second toolbar to reorder the narrative rows
### Answering Yes/No Questions

**Proposal Number:** 00025382  
**Sponsor:** 002380 : Carnegie Corporation of New York

<table>
<thead>
<tr>
<th>Code</th>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Is there a lab or facility space change that would result from this proposal?</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Are human embryonic stem cells used? If so, please click on ‘More’ for instructions.</td>
<td></td>
</tr>
<tr>
<td>P1</td>
<td>Does this project require Biosafety Level 3 (BSL-3) handling? (BSL-3 means work with agents that may cause serious or potentially lethal disease through inhalation route exposure.)</td>
<td></td>
</tr>
<tr>
<td>P2..</td>
<td>Are you collaborating with Cuba, Iran, North Korea, Russia/Ukraine, Sudan, or Syria?</td>
<td></td>
</tr>
<tr>
<td>P3</td>
<td>Does this proposal involve human subjects? The definition of human subjects is met if an investigator conducting research obtains data through interaction with an individual, or obtains identifiable private information on a living individual where no interaction with the individual is required. If yes, please include protocol information on the Special Review tab.</td>
<td></td>
</tr>
<tr>
<td>P4</td>
<td>Does this proposal involve animal research? If yes, please include protocol information on the Special Review tab.</td>
<td></td>
</tr>
</tbody>
</table>

**Explanation:**

**Review Date:**
The Yes/No Questions (YNQ) button contains mandatory questions about the proposal.

The questions are also in a fillable Adobe form called the "PI Yes/No Questionnaire" on the Coeus Forms page. Download the form and send it to your PI, then you can copy the answers to Coeus.

If the answer to any of the export control questions P6 through P9 is Yes, fill in further details on the Special Review tab.

Answering Yes to questions P1 and P2.. automatically triggers University Research Board (URB) review of the proposal, which occurs after the proposal has been submitted to the sponsor. See the URB section of this manual for details.

How to fill out the YNQ

Click on the Yes/No Questions button
The Adobe Fillable version of the YNQ is available [here](#) on the Coeus Forms page. Give this form to your PI, then transcribe the answers from the form into Coeus. Answer each question. Answering yes to some questions may require a description in the explanation box. Use the scroll bar to access all questions, then click OK.
Submitting the Proposal for Routing

In order to submit a proposal, you must have:

- Certified investigators (see Investigators section)
- Answered the YNQ (see YNQ section)
- Marked your budget final and complete (see Budget section)
- Changed all narratives/attachments to complete (see Narratives section)

Press the submit button in the second toolbar.

- The approval map is displayed
- The proposal status changes from "In Progress" to "Approval in Progress"

How to Submit for Approval
NOTE: If you get this message:

Submission of proposal failed because no routing stops have been defined.

“Submission of proposal failed because no routing stops have been defined” means that there is no budget entered. If your proposal doesn’t require a budget (possible with white papers/letter of intent/pre-proposal), you still need to mark the $0 budget as final and complete. Go to the budget, click on the New button, click OK to the next box, and
change the status of the budget to Final and Complete without entering any budget data. You will then be able to submit the proposal.

- **NOTE:** If you get the "Lock deleted by DB Admin" message when trying to submit, close Coeus, reopen Coeus and it should be ok.

- If you copy a proposal and then try to submit it, Coeus states the narratives are incomplete, even though they are marked as complete. This is normal behavior; Coeus is basically asking you to confirm you really don't want to make changes to the narratives. However, sometimes when you start a brand new proposal from scratch, and you mark all narratives as complete, Coeus might tell you that the narratives are incomplete. We found that setting the status of one narrative from complete to incomplete, then changing it back to complete and pressing save, seems to resolve this issue and you will be able to submit.

---

**The Approval Process**

**Approval Maps**

Maps are already set in Coeus.

- Each map should have one primary and at least one secondary approver
- Only one person on the map for that unit needs to approve
- Changes to approvers? Let me know.

Approvals must be done by one person from each unit listed on the Investigator and Key Person tabs before the proposal is reviewed by ORPA

- If chemistry and physics are collaborating on a proposal, both chemistry and physics must approve the proposal.
- If the proposal is through a center like PRISM and the PI's home unit is EE, both EE and PRISM must approve the proposal.
- If the proposal is through an engineering dept, SEAS must also approve the proposal.
- After all depts approve the proposal, then ORPA reviews it and submits it to the sponsor.
- If the proposal meets criteria for URB review, it will be sent to the URB. See the URB section of this manual for details.

Approving can be done in Premium or Lite

- Outlook mail has URL for CoeusLite, but it can be approved in Premium.
- If you want to approve on your mobile device, you must use CoeusLite.
"Waiting for Approval" Emails

Two approval emails are sent: one to the primary approver, and another email to all secondary approvers.

![Email Example]

**Subject is "waiting for approval"**

**This is the email sent to the Primary Approver**

**Proposal is waiting for approval**

**Default Info**

**Link to CoeusLite (but you can approve in Premium if you prefer)**
23500 - Proposal 00018334 is waiting for approval

coeusadm@princeton.edu

To: Coeus Test Mail

Thursday, February 25, 2016 4:00 PM

TEST MODE
In Production mode this mail will be sent to
[ pzaurov@princeton.edu gruschow@Princeton.EDU
warterbu@princeton.edu mc19@princeton.edu ]

You are designated as an alternate approver for this proposal.

PI: Einstein, Albert
Lead Unit: 23500 ; CHM-Chemistry
Proposal Number: 00018334
Sponsor: National Institutes of Health
Deadline Date: March 5, 2016
Title: Kyle's proposal for the PD manual
Sponsor Announcement: This is the sponsor's opportunity title.

Please use the link given below for the project details.

You can view this proposal through CoeusLite at the following
address: https://puwebd.princeton.edu:8443/irb/displayProposal.do?proposalNo=00018334
How to Approve/Reject/Recall in Premium

In Premium, find and open the proposal, click on the approval button in the second toolbar to open the proposal routing panel, then:

- Click Approve to approve
- Click Reject to reject
- Click Recall to remove the proposal from routing ("Oops I didn't mean it!" or "Oops I just saw a typo" or "Oops I forgot to upload something").
- Instead of asking an approver to reject it, if you have the ability to submit, you have the ability to recall.
Double click on the proposal in the search results list

Even if you’re not an approver nor an aggregator, you can click on the Flag button to view the approval routing map.

After submitting, if you’re an approver, you can press the approve or reject buttons.

If you’re an aggregator (meaning you have the right to submit proposals), you can also recall proposals from routing.
Rejecting in premium

Click on the Proposal Development button

You can fill in approval comments if you want to, but you don't have to. Princeton does not use the Attachments tab.

Click Approve again to confirm approval.

Click Approve
1. Search for the proposal
2. Click Find

Double click on the proposal in the search results list
Even if you're not an approver nor an aggregator, you can click on the Flag button to view the approval routing map.

After submitting, if you're an approver, you can press the approve or reject buttons.

If you're an aggregator (meaning you have the right to submit proposals), you can also recall proposals from routing.
1. Click Reject

2. You must fill in rejection comments.

3. Click Reject to confirm rejection.

Princeton does not use the Attachments tab.
Recalling in premium

You should alert the approvers at the current step that you are going to recall...

...as a professional courtesy in case they are actively reviewing the proposal.

Recall works in Premium or Lite

Recall only works for aggregators (people with the Coeus right to submit proposals)

Proposal can be recalled no matter who has already approved...

... as long as the proposal status is "approval in progress."

Recalled proposals can be edited and resubmitted.

Only the aggregators receive "proposal has been recalled" email.

Approvers do not get recall email.

Recall comments are in the notepad.

Coeus inbox notification sometimes incorrectly shows the primary approver recalled the proposal (bug).

Click on the Proposal Development button
1. Search for the proposal.
2. Click Find.

Double click on the proposal in the search results list.
Even if you're not an approver nor an aggregator, you can click on the Flag button to view the approval routing map.

After submitting, if you're an approver, you can press the approve or reject buttons.

If you're an aggregator (meaning you have the right to submit proposals), you can also recall proposals from routing.
How to Approve, Reject or Recall in CoeusLite

Approve in Lite

Access lite at https://puwebp.princeton.edu:8443/irb/userAuthAction.do
Reject in Lite

Access lite at https://puwebp.princeton.edu:8443/irb/userAuthAction.do
2. Click "Full Proposal Details" to view more Proposal Information, then click Approve, Reject, or Recall.

Clicking on the link in the approval email will lead you to this page.

---

Rejection comments are mandatory.

Princeton doesn't use this functionality.

Press Reject to reject the proposal, or press Back to cancel.
Recall in Lite

Access lite at https://puwebp.princeton.edu:8443/irb/userAuthAction.do

1. Click on the link in the approval email, or log on to Lite at https://puwebp.princeton.edu:8443/irb/

2. If the proposal doesn’t immediately display, click on Inbox

CoeusLite


Welcome to CoeusLite

Primary Features of Coeus Lite include:

- My Protocols - Allows Principal Investigators to prepare and submit protocol applications and review detailed information associated with their existing protocols.
- My Proposals - Allows Users to view and prepare grant applications and route their applications for Institutional Approval. Institution Administrators can see and approve grant applications. Institute Approvers can view, approve, or reject proposals for correction. OSP Authorized Administrators can submit applications to Grants.gov.

Unresolved Messages for Coeus Application

Click on the link for the proposal title or number

Move Selected Messages

Proposal Title: Kyle’s proposal for the PD manual
Proposal Number: 00018334
Date Received: 02/26/2016, 04:00 PM

CoeusLite


Proposal Summary | Full Proposal Details | Approval Routing

Approve | Reject | Recall

Validation Checks

Clicking on the link in the approval email will lead you to this page.

2. Click “Full Proposal Details” to view more Proposal information, then click Approve, Reject, or Recall

Investigator: Einstein, Albert
Agency/Sponsor: 000340: National Institutes of Health
Title: Kyle’s proposal for the PD manual
Proposal #: 00018334 (Approval in Progress)
Proposal Period: 11/01/2017 - 10/31/2020

Budget Summary

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Direct Cost</th>
<th>Indirect Cost</th>
<th>Under Recovery</th>
<th>Cost Sharing</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>11/01/2017</td>
<td>10/31/2019</td>
<td>$906,117.08</td>
<td>$55,744.50</td>
<td>$57,612.10</td>
<td>$0.00</td>
<td>$964,518.56</td>
</tr>
<tr>
<td>2</td>
<td>11/01/2018</td>
<td>10/31/2019</td>
<td>$301,930.00</td>
<td>$17,620.10</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$319,550.10</td>
</tr>
<tr>
<td>3</td>
<td>11/01/2019</td>
<td>10/31/2020</td>
<td>$314,317.50</td>
<td>$19,244.83</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$333,562.33</td>
</tr>
</tbody>
</table>

Budget Report

Report Name: Budget Summary by Period
Cost Sharing Summary by Period
Cumulative Budget
Industrial Budget by Period

Attachments

Type: Narrative
Description: Complete
Proposal Print

View
Press Recall to recall the proposal from approval routing, or press Back to cancel.
Approved, Rejected, and Recalled Emails

Approved email

After Dept approval, the person who approved does not get Outlook email.

If the primary approver approved the proposal, one email is sent to the secondary approvers

• Subject and message “proposal approved by other user”.

If someone other than the primary approver approved the proposal

• One email is sent to the primary approver (subject: “is approved”, message: “proposal approved by other user”)
• One email is sent to the other approvers (subject and message “proposal approved by other user”)

Message moves to Coeus resolved tab for all

After ORPA approval

• All aggregators receive Outlook mail with IP number
• Coeus notification stays in Coeus inbox in unresolved tab
23300 - Proposal 00020976 has been approved by ORPA

coeusadm@princeton.edu

Coeus Proposal Development #

Coeus Institute Proposal #

The Institute proposal number is 00029002

PI:          Bassler, Bonnie L
Lead Unit:    23300 : MOL-Molecular Biology
Proposal Number:  00020976
Sponsor:     American Chemical Society
Deadline Date: Title:  KB: Another PS Image 16 Award, Foundation
Sponsor Announcement: Comments:

Please use the link given below for the project details.

You can view this proposal through CoeusLite at the following address: https://puwebq.princeton.edu:8443/irb/displayProposal.do?proposalNo=00020976

This email is sent to the aggregators (those who can submit proposals for their dept) after ORPA approves the proposal in Coeus.
Rejected email

The person who rejects does not get Outlook mail.

Regardless of who rejects it, one email is sent to the other approvers with the subject/text as “proposal rejected by other user”.

Message moves in Coeus inbox for all to resolved tab

![Email screenshot](image-url)
Recalled email

Recalled in Premium? The aggregators receive the recall email (not the approvers)

Recalled in Lite? No email is sent to anyone (known bug)

---

Proposal 00018446 has been Recalled

(coeusadm@princeton.edu)

To: Coeus Test Mail

Friday, October 24, 2014 5:27 PM

-----------------------------------------------

TEST MODE
In Production mode this mail will be sent to [ kburkhar@princeton.edu
cgathers@princeton.edu chacko@princeton.edu corinna@princeton.edu cp@princeton.edu
denised@princeton.edu gruschow@Princeton.EDU mc19@princeton.edu
mkrause@princeton.edu pzaurov@princeton.edu smullins@princeton.edu sp7@princeton.edu
tbrennen@princeton.edu warterbu@princeton.edu ]

-----------------------------------------------

Proposal 00018446 has been Recalled from routing by NET ID kburkhar. Please use the link given below for the project details.

You can view this proposal through CoeusLite at the following address:

---

Coeus Inbox

You will have email in your Coeus inbox if:

• If you’re an approver you’ll receive “Needs to be approved” proposal messages
• If you’re an aggregator (someone who can submit proposals) you’ll receive “Approved by ORPA” messages, or someone recalls a proposal
• If someone sends you an email using the Coeus email button
• NOTE: These messages will also be in your Outlook mail
Two tabs:
Unresolved is your Inbox.
Resolved is your Trash.

Message
You are designated as an alternate approver for this proposal.
Dept approvers: after dept approval, message moves to resolved

Notifications (like “ORPA approved” or an email from a colleague): stays in unresolved until you move it

For notifications that don’t move on their own (like notifications), select a message and press the delete button to delete it permanently.

If you press "change status", the message moves to the Resolved tab. Messages in the Resolved tab are automatically deleted after 60 days.

If you leave your inbox open all day, it doesn't update itself automatically. Click the Refresh button to refresh the view.
What happens in Coeus after everyone approves?

Coeus Proposal Development status is Submitted

- Submitted is a terminal status

Coeus automatically creates an Institute Proposal

- IP status is Pending

And now we wait to hear from the sponsor!

Viewing all recall and rejection comments in the Notepad

To view all rejection and recall comments in one place, click on the Notepad

Click the yellow folder icon to close the notepad and return to the other proposal tabs.
To see where the proposal is in the approval map, or to view approval, rejection, and recall comments in the approval screen:

1. Press the Approval button.
2. Click on a level whose comments you want to see. Red Rubber Stamp means that level approved. Yellow stamp means that level has not approved yet.
3. Click on the name of the person who approved or rejected.
4. If they entered comments (optional for approval, mandatory for rejection) the comments will appear here.
5. Press close.
Viewing submission attempts

Click on the Approval flag

**Proposal Details - 00018324**

**Proposal No:** 00018324  
**Status:** Approval In Progress

**Lead Unit:** 23500: CHM-Chemistry

**Title:** Kyle's proposal for the PD manual

**Routing**
- **Routing Start Date:** 2016-02-25 16:00:23.0 by Zaurov, Panina
- **Routing End Date:**
- **Recall Comments:**

**Submission Number:** 4

**Show Previous Submission**

Click this button to see when a previous attempt occurred and who recalled/rejected

**Sequential Step 1**
- **dmacill:** MacMillan, David W  
  Waiting for Approval
- **mct19:** Checkovage, Michael J  
  Waiting for Approval
- **waterbu:** Arterburn, Wendy D  
  Waiting for Approval
- **gzaurov:** Zaurov, Panina  
  Waiting for Approval
- **gruschow:** Gruschow, Janet G  
  Waiting for Approval
Correcting a rejected or recalled proposal

If the proposal is rejected by a departmental person or ORPA, or recalled, you should open the proposal in Edit mode, make the corrections, and submit the proposal again. It will then make its way through the proposal map starting at the first step.

There is an urban legend that if your proposal is rejected, you have to copy it and make the corrections and submit the copy. You can just make the corrections and submit again.
**BUG: Coeus inbox notification bug with recalling**

In the above example, another aggregator recalled the proposal but the Coeus inbox (premium and Lite too) show that the proposal was recalled by the primary approver (the Chair).

**BUG: Proposal routed by aggregator**

Proposal Routing shows the correct day, time, and user in the “routing start date” section. The correct day and time but the wrong user are displayed in the “routed by aggregator section”.

Sometimes the Coeus inbox shows the proposal was recalled by the primary approver when it was actually recalled by an aggregator.
Closing and editing proposals

You don’t have to do all your editing & submitting in one session.

Use the yellow folder icon to close the proposal

Use the door icon in the first toolbar or red x to close Coeus completely

Closing the proposal when you’re not ready to submit

[Images and diagrams showing the Coeus interface with highlighted icons and instructions for closing the proposal]

Done editing for now but not ready to submit? Click on the yellow folder icon to close the proposal.

Click on the folder to close the module.

Click on either the door icon or red X to log out.
Editing an existing proposal

Click on the Proposal Development icon

1. Search for the proposal # (Use * in place of zeros for faster searching)
2. Click Find

It is very tempting to double click on the proposal, but that will open the proposal in view-only mode.

To edit the proposal, press the Edit button
The boxes are white, so you are now in Edit mode and can edit the proposal.
Finding the proposal when you don't know the proposal number

If you don't know the proposal number, you can search for "in progress" proposals, or search by PI name, part of the title, etc.
<table>
<thead>
<tr>
<th>Status</th>
<th>Deadline Date</th>
<th>Investigator</th>
<th>Unit Number</th>
<th>Unit Name</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>water*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remember, if searching on an investigator's name, enter their last name (or part of their last name) and a *.

The query will be applied to only those proposals where the current user, KBURKHAR plays one of the selected proposal roles.

**Selected Roles**
- Aggregator
- Approver
- Budget Creator
- Conflict of Interest Dept Viewer
- Narrative Writer
- Viewer

**Available Roles**

<< Add  Remove >>
Copying an Existing Proposal (same lead unit)

If searching on a title, enter part of the title with * before AND after the word you are searching on.

Click on the Maintain Proposal Development button.

Search for the proposal. (Use * in place of 000)
Your new copy will be at the very bottom of your Proposal search results list.

**NOTE:** If you are authorized to create proposals for more than one department, you will be prompted to indicate the unit submitting the proposal. Make sure you select the right department, since the unit number can’t be changed during the proposal process.
1. If the proposal dates have changed, follow the instructions in the “Changing Proposal Dates” section of this manual.
2. Be sure to sync the rates if you have copied the budget. You may also need to adjust salaries and/or effective date in the Budget Persons (red running guy button) and in the Personnel button (red baron) for each period.

**NOTE**: If you have trouble copying a proposal, there could be a few reasons why. If you were not an aggregator on the original proposal, it will not let you copy the proposal and you will have to ask a coworker who was an aggregator on the original proposal to copy it for you and add you as an aggregator to the copy.

If you were an aggregator on the original proposal, there may be a corrupted, uploaded file in the narrative of the proposal you’re trying to copy. If it’s the latter case, usually Coeus will let you copy at least the budget.

If you copy a proposal where the UR rate type is not MTDC, in the copy, the UR rate type defaults back to MTDC. You have to change the copy's UR rate type to match the OH rate type.

### Copying an Existing Proposal (from one lead unit to a different lead unit)

Need to have a proposal copied from one unit to another? The Coeus Coordinator can copy it for you. Just let coeus_help@princeton.edu know:

- The proposal number that needs to be copied and the new unit #
- Which narrative rows need to be removed or replaced.
  - Somehow the new unit aggregators can’t replace or delete narrative files, but the Coeus Coordinator can delete the rows for you. Then you can add the new rows and upload the new narratives.
  - If all narrative rows need to be removed/replaced, then the narratives will not be copied.
- Which aggregators in the new unit need access to the copied proposal.
  - When the proposal is copied, it doesn’t add all the aggregators in the new unit, but the Coeus Coordinator can add them.
Editing a proposal that has been rejected or recalled

Unlocking your locked proposal

You want to edit your proposal but Coeus says you’re using it, do you want to open in display mode?

- Why does this happen?
  - Coeus crashed
  - Your computer crashed
  - Proposal wasn’t closed properly
  - No reason at all!

- You can unlock it yourself, if the proposal is locked by your own account
  - Go to File > Current Locks and unlock each row

- If the proposal is locked by someone else’s account...
  - Ask them to unlock it
  - If they are not available, call Kyle or Chiz, and they can unlock it.
Highlight the row (so it is blue) and click Unlock. If there is more than one row, repeat until all rows have disappeared. Then click Close.
You should be able to edit your proposal now.
Deleting proposals

Who can delete? What kind of proposals can be deleted?

Only aggregators (people who can submit proposals) can delete proposals

Only "in progress" proposals can be deleted.

• Once the proposal has been submitted into routing, it cannot be deleted.

Once a proposal is deleted, it is gone forever

• No one can get the proposal to come back, not you, not me, not the database admin. It's gone for good! There is no way to "get it back".

How to delete

1. Search for the "in progress" proposal you want to delete and highlight it in the search results list
2. Press the Delete button
3. Click on Yes
What if you get “null is using proposal” when you try to delete a proposal?

Open the proposal in edit mode and remove all the narrative files, press save and close the proposal. Then try deleting the proposal. If that doesn’t work, then open the proposal in edit mode and delete the budget, press save and close the proposal. Then try deleting the proposal.

What if you want to delete a proposal hierarchy?

If you need to delete a hierarchy, unlink all children from the parent, and the parent will disappear for good, then you can delete the children. If you get “integrity constraint” error messages while trying to unlink the children from the hierarchy, then the hierarchy is probably corrupted somehow and you can’t delete the proposals because you can’t undo the hierarchy.

The proposal is now gone for good!
Cost Share / Cost Sharing & Coeus Proposal Development

The directions in this manual apply to cost sharing and how it relates to the Coeus Proposal Development module at the proposal stage. Documentation about cost sharing is available as:

- Cost Sharing Business Process Quick Guide
- Cost Sharing Business Process Detailed Guide
- Cost Sharing Summer 2015 Presentation (ppt)

For more information about cost sharing, please contact your GCA.

**What is cost share / cost sharing?**

Cost sharing is when the university is picking up part of the cost of a sponsored research project.

- Mandatory cost sharing (required by sponsor) must be included in the Coeus budget.
- Voluntary cost sharing (not required by the sponsor):
  - If it is not specific amounts/percentages, it cannot be included in the Coeus budget.
  - If it is specific amounts/percentages, it must be included in the Coeus budget.
- For personnel, cost sharing includes benefits

**Cost Share Commitment Letters/Commitment Forms / Cost Sharing Commitment Letters/Commitment Forms**

- Upload cost sharing commitment letters or signed commitment forms as applicable for each dept contributing cost sharing in the Coeus narrative section as type “Cost Sharing”

Add a row for each cost sharing commitment letter or Commitment form as needed.
Cost Share Budget / Cost Sharing Budget

NOTE: Coeus will automatically calculate OH on cost sharing items regardless of if the sponsor allows OH to count toward the university’s cost sharing commitment. You can distribute the OH to unit 51701 (ORPA’s unit #)

Entering cost share / cost sharing for personnel using the red baron

1. Click on the Running Guy
2. Enter the Calc Base salary for that person as of the Eff Date
3. Click OK
Entering cost share / cost sharing for personnel without using the red baron

1. Click Add
2. Select the cost element.
Entering cost share / cost sharing for non-personnel costs

Double click on the line item. The Budget - Line Item Detail box appears.

Fill in the cost to sponsor in the Cost box. Fill in the Cost Sharing amount in the Cost Sharing Box. Click OK.

Click Add

Select the cost element
Double click on the line item. The Budget - Line Item Detail box appears.

Fill in the cost to sponsor in the Cost box. Fill in the Cost Sharing amount in the Cost Sharing Box. Click OK.

Viewing cost share / viewing cost sharing

There is cost sharing in this budget period because there is a value in the cost sharing box. But how can you tell which line items have cost sharing? Click on the wrench icon.
Check off Cost Share. While you’re here, check off "Show Calculated Amounts" Click OK.

Move the horizontal scroll bar to the right

Now you can see which line items have cost sharing.

Here are the OH and EB for the highlighted line above, for cost to sponsor and cost sharing amounts.

NOTE: You will have to repeat these steps to see cost sharing in each period. Also once you close the budget and reopen it, it will return to the default view.
Distributing cost share / Distributing cost sharing

You must know which unit number is picking up the cost sharing amounts. This is called the source of the cost sharing.

<table>
<thead>
<tr>
<th>Cost Sharing Type/Source</th>
<th>Dept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graduate School Tuition subsidy (if sponsor is paying full 62% OH rate and allows this subsidy to count towards the university’s cost sharing commitment)</td>
<td>40000</td>
</tr>
<tr>
<td>DFR</td>
<td>51700</td>
</tr>
<tr>
<td>Provost</td>
<td>51005</td>
</tr>
<tr>
<td>OH*</td>
<td>51701</td>
</tr>
<tr>
<td>Faculty AY S&amp;B</td>
<td>Contributing dept’s main unit # (ends in 00)</td>
</tr>
<tr>
<td>Dept Funds</td>
<td>Dept # that is contributing the cost sharing. It may be a dept’s main # (ends in 00) or a subdept #.</td>
</tr>
</tbody>
</table>

*NOTE: Coeus calculates OH automatically on cost shared items, even if the sponsor does not allow OH to count toward the University’s cost sharing commitment. Either way, distribute the OH to 51701 (ORPA).
Simple cost sharing case: Only One Dept involved and no overhead

NOTE: Only distribute cost sharing when you are done entering all cost sharing amounts and there are no more changes to be made to cost sharing.

Simple case: Items have no OH, and only one unit is contributing to the cost sharing amount. Ignore Percentage and fill in the Dept # in the Source Account. Click OK.
Simple cost sharing case: Only One Dept involved and there is overhead

1. Click Add

3. Reduce the Amount here by the amt of the OH. Enter the Unit # picking up this cost sharing.

2. Enter the amount of the OH for this FY on the new row. Enter 51701 as the Source Account.

Repeat for each FY & Click OK
More complicated cost sharing case: Multiple units contributing cost sharing, and there is OH cost sharing only in the first year of the budget.

Add a row for each dept contributing cost sharing for that FY. Update or add amounts for each contributing dept, and enter the dept # in the Source Account box.

Repeat for each FY.

Click OK.

Cost sharing only in the first year of the budget.

Cost sharing only in year 1? Enter the dept # picking up the cost sharing in the source acct box.

Then highlight the $0 rows and click on the delete button to delete the $0 rows.

Coeus will not let you click OK until you delete the $0 rows.
Cost share distribution / Cost sharing distribution problems & tips

The cost sharing distribution screen can get complicated pretty quickly. Tips:

Initially distribute all years to ONE unit, and click OK. Then distribute year by year, clicking OK after each year’s distribution. That way, if you get this error message, you’ll know which rows need adjusting: “Please check amount, the total amount from the distribution list should be equal to $X”:

If you are really stuck, you can always delete all lines in the cost sharing distribution screen, click ok, and start your distribution over.
Proposal Hierarchy

**What is a proposal hierarchy?**

Proposal hierarchy is a way of combining multiple smaller budgets (child budgets) into one big budget (parent budget).

**Why create a proposal hierarchy?**

There are many reasons why you may want to or should create a proposal hierarchy.

- A proposal has 2 or more co-PIs, and each PI wants to see his/her budget separately.
- Two or more departments are participating on a proposal, and each dept wants to see their budget separately.
- A sponsor pays different overhead and/or employee benefit rates on different cost elements.
  - Note: This is not the on/off campus case. On and off campus can be handled in the same budget screen. Double click on the line item and select the "off campus" radio button.
- NIH K99/R00 "Pathway to Independence" proposals where the first two years are at 8% OH and the last 3 years are at 62% OH
- NIH F99/K00 "Predoctoral to Postdoctoral Fellow Transition" proposal where the first 1-2 years are at 0% and the last 3-4 years are at 8%
A Basic Understanding of Coeus' Proposal Hierarchy

If you've never done proposal hierarchy before, the important concept to understand is the children are created first, then the parent (this is the opposite of the pre-Prime award module, where the parent is created first, and then the children). Any changes to the budget are made to the children, then synced to the parent proposal. The parent budget cannot be edited in the parent itself—all budget changes must be in the children and synced to the parent.

Proposal hierarchy is different from other hierarchies!

Child proposals are created first, not the parent

- Each with the same lead unit (different depts can each have a child proposal, but the lead dept starts each child proposal and assigns Coeus rights to the other depts to work in those proposals).
- Each with their own Proposal Development number
- Each with their own budget (a budget has to be started for each child in order to create the hierarchy)

One child is chosen to create the parent

- Select one of the children and use it to "create hierarchy".
- Coeus then copies the child you selected to create the parent. The parent has its own Proposal Development number which Coeus automatically assigns.
- Do NOT manually add a proposal as a placeholder for the parent

Remaining child proposals are linked & synced to the parent

- Open the parent proposal and link the other child proposals to it, or open each child proposal and link each to the parent (a budget has to be started in each child before it can be linked)

Tips

- Upload the narratives and enter special review information in child 1, not the parent (because if you have to create the hierarchy again, you'll copy the children, not the parent).
- Certify the investigator(s) and answer the YNQ in the parent. (If you do certify the investigator(s) and answer the YNQ in the child proposals, you will have to do it all over again in the parent.)
- If s2s, make the Grants.gov connection in the parent (if you make the GG connection in the children, you'll have to make the connection again in the parent.)
- The proposal hierarchy is only two levels, the top level parent and second level children. When the parent is routed for approval, the whole hierarchy is routed. The status of the child and parent proposals are the same.
- The lead unit of the parent and child proposals are always the same (Different depts can each have a child proposal, but the lead dept starts each child proposal and assigns Coeus rights to the other depts to work in those proposals).
- The lead PI of the hierarchy is the person checked off as the lead PI in the parent proposal.
- The lead PI can be chosen in the parent
Proposal hierarchy tables

Create a proposal hierarchy table to make your life easier!

- Multiple PIs on one proposal:

<table>
<thead>
<tr>
<th>Child # or parent?</th>
<th>Proposal number</th>
<th>Additional Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child 1</td>
<td>00024787</td>
<td>Prof Smith</td>
</tr>
<tr>
<td>Child 2</td>
<td>00024788</td>
<td>Prof Jones</td>
</tr>
<tr>
<td>Child 3</td>
<td>00024789</td>
<td>Prof Grady</td>
</tr>
<tr>
<td>Parent</td>
<td>00024790</td>
<td></td>
</tr>
</tbody>
</table>

- Different OH rates on one proposal:

<table>
<thead>
<tr>
<th>Child # or parent?</th>
<th>Proposal number</th>
<th>Additional Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child 1</td>
<td>00024800</td>
<td>Items with OH at 33%</td>
</tr>
<tr>
<td>Child 2</td>
<td>00024801</td>
<td>Items with OH at 62%</td>
</tr>
<tr>
<td>Parent</td>
<td>00024802</td>
<td></td>
</tr>
</tbody>
</table>

- NIH K99/R00 proposal:

<table>
<thead>
<tr>
<th>Child # or parent?</th>
<th>Proposal number</th>
<th>Additional Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child 1</td>
<td>00028541</td>
<td>First 2 years at 8% OH</td>
</tr>
<tr>
<td>Child 2</td>
<td>00028567</td>
<td>Last 3 years at 62% OH</td>
</tr>
<tr>
<td>Parent</td>
<td>00028570</td>
<td></td>
</tr>
</tbody>
</table>
General proposal hierarchy creation, step-by-step

Create the first child proposal. (Note: The children are created before the parent!)

• Write down this proposal number (follow the example of the chart above).
• The lead unit for a child is the lead unit for the entire proposal
• Fill out the Proposal tab
  • You can include “child 1” in the title if you’d like
• Fill out the Investigator tab
  • If the hierarchy is being created because there is more than one PI and each PI wants to see his/her budget separately, enter the PI for this budget only

Add the Budget for child 1

• Include a brief description for each budget line
• Why is the cost in this budget?
  • Different PI?
  • Different OH rate?
• Mark the budget as final and complete if possible
  • You don’t have to, but it does simply your life
  • You can mark it final/complete later if you need to
• If this child has cost sharing, enter and distribute the cost sharing in this budget.

Add ALL Narratives and Special Review information in child 1

• Why? If you need to copy your hierarchy, you have to copy the children and then choose a child to make the parent.
• So if your narratives and special review information were only in the parent, you will have to upload or add them all over again
• When you copy a parent proposal, it only copies the parent, it does not copy the children too. (It does not copy the hierarchy.)

What not to do in Child 1

• Do not answer YNQ (if you do, you’ll have to answer the YNQ again in the parent.)
• Do not certify the investigator (If you do, you'll have to certify again in the parent.)
• Do not make the Grants.gov connection for s2s proposals. (If you do, you'll have to certify again in the parent.)

Create the remaining child proposals

• Write down the numbers for each child
• Create child proposals 2, 3, 4, etc
• Each child proposal has a different proposal number
• You could copy child 1 and make changes for child 2, or start child 2 from scratch
  • Copying is recommended because start/end dates will definitely be the same. (All child proposals must have the same start/end dates)
• Do not copy the narratives or budget. (The narratives are already in child 1 and don't need to be duplicated in other child proposals. The budget will be different in each child.)
• Each child must have a budget before continuing! If a budget has cost sharing, enter and distribute the cost sharing in that child.
• Do not answer the YNQ, certify the investigators, or make the GG connection for s2s proposals.
Create the hierarchy

- Note: Your child proposals must have budgets before creating the hierarchy
- They don’t have to be final and complete, but they have to be started.
- Open child 1 in Edit mode
  - From the Edit menu, select “Create Hierarchy”

If the proposal does not have a budget version marked “final” the following message will be displayed. Click OK to create a hierarchy using the latest version of the budget.

Coeus then displays this message with the parent proposal number, which is a higher number than the child. Write this number down too!
Open the parent in Edit mode

- Update the proposal title if necessary
- From the Edit menu, select “Link Child Proposal”

Select "Sub Budget" & click OK

- This means you want to include all budget line items
Search for Child 2, select it and click OK

- Child 2 has to have a budget.
- The start/end dates for child 2 have to be the same as child 1.
If the proposal does not have a budget version marked “final” the following message will be displayed. Click OK to create a hierarchy using the latest version of the budget.

Some Coeus narrative types are only allowed to exist one time in a proposal (For example, narrative, facilities, and equipment attachments can only exist once.) If child #1 has these types, they are synced to the parent. If child #2 also has these same types, they will not be synced to the parent because they can only exist one time in the parent. It’s better to upload attachments only in child #1 to avoid confusion.

Coeus then states the child has been linked to the parent.
Repeat linkage with child 3, 4, etc

- All children have to have the same proposal start/end dates and all children must have a budget started.
- You could open each child proposal in Edit mode and from the Edit menu select "Link to Hierarchy", but it's faster to open the parent proposal in Edit mode and link children to the parent.

The Proposal tab icons display if the proposal is a parent (+) or child (-). A sync button is now in the second toolbar to sync changes from the children to the parent.
Now the parent and each child have a Proposal Hierarchy tab and a sync button in the second toolbar.

- Click `+` to expand to see all budget versions.
- Click the sync button to sync all changes from child budgets to parent budgets.
- New tab!

Goal is for all boxes to be green (synced) instead of red (not synced).

Click "show legend" button to see what all icons mean (click "Hide" to hide the legend).
If each child had a different PI, all PIs are listed on the Investigator tab

- Select one as the lead PI and lead unit in the parent

The parent displays the Child 1 PI & Child 2 PI. Child 1 PI is checked as lead. If needed, change the lead PI & lead unit here.

If you need to add more PIs, add them in the child proposals.
Review the parent budget. The parent budget shows all line items from each child.

• Summary tab: Sums all costs from all child budgets. The parent budget status cannot be changed to Complete unless the child budget statuses are all Complete.

• Period tabs: If a description was entered in each child, it makes it easy to see which items are from each child.

Parent budget can only be set to Complete if the child budgets are set to Complete.

Child 1 items (yellow—Cava in the description)
Child 2 items (orange—Sarmiento in the description)
By filling in the description, it’s easy to see which items are from which child proposal.
Make budget changes and mark budgets final and complete

- Budget changes can only be made in the children, not in the parent. Make the changes in the child proposal budgets and sync in the budget screen or sync outside of the budget screen. It's faster to make the budget changes in each child, then open the parent and press the sync button in the parent, outside of the budget screen.
- Mark child budgets as final & complete, then sync.
- Mark parent budget as final & complete

If you need to make budget changes after marking the children and parent as complete:

- Mark the parent budget as incomplete
- Mark the child budgets as incomplete
- Make the changes in the child budgets
- Mark the child as complete and sync to parent
- Mark the parent as complete

Need to make narrative changes? Add or change them in child 1 and sync. Coeus tells you at the bottom of the parent narrative screen where the file was uploaded--that's where changes can be made.

The parent total tab sums by each cost element across all budgets.
With the parent open in Edit mode (after linking all child proposals)

- Answer the YNQ
- Certify the investigators
- Verify the lead PI or check off a different PI as the lead if needed
- If s2s, make the Grants.gov connection

Submit

- Make final changes in parent
- Press sync one final time in the parent. In the parent, click on the Proposal Hierarchy tab, click on the + sign to expand all boxes and make sure all boxes are green, not red.
- Submit parent
- The status of all child proposals will be the same as the parent proposal, "approval in progress". (You may have to search for the proposals again to see the status update on the search results screen.)

Special Note about TBA people in proposal hierarchy

Special note about TBA people

- If there is the same TBA type in both child 1 and child 2, their job codes MUST be different
- For example, there are 2 TBA Grad Assistants, one in child 1 and one in child 2.
  - Child 1: TBA Grad Assistant, job code TBA1
  - Child 2: TBA Grad Assistant, job code TBA2
- If you don’t change the job codes to be different, Coeus will give an unclear error message.
Rights required for creating and maintaining hierarchy

General rights

In order to create a new hierarchy, you have to be an aggregator in the child proposal. (Aggregator is a Coeus role that means a person can do anything in a proposal including creating and submitting a proposal for approval).

In order to link the child proposals to the parent, you must be an aggregator in both the child and the parent proposals.

Assigning rights when there are multiple depts. on one proposal

In this example:

- There are 3 professors/depts. on one proposal.
- PRISM (a center) is the lead dept and will submit the proposal and administer the award if it is funded.
- Three PIs are on this proposal: one from EE, one from CS, and one from MAE.
- Each professor wants to see his/her budget separately.
- PRISM wants the dept administrator from each participating dept to enter their dept’s budget information.
- PRISM creates the three child proposals and assigns the budget creator or aggregator role to the other dept administrators.

- Assigning the budget creator role means the person with that role can only sync the budget to the parent (they have to be in the budget screen when they press sync.)
- Assigning the aggregator role means the person can sync the entire child proposal to the parent
- PRISM selects one of the child proposals to create the parent from (the child must have a budget).
- PRISM links the other child proposals to the parent (the other children must each have a budget).
- PRISM does the final sync and submits the proposal for approval.
What if someone rejects the proposal and budget changes need to be made?

- Edit your proposal hierarchy
- Mark parent budget as incomplete
- Mark child budget(s) as incomplete
- Make changes to child budget(s)
- Mark child budget(s) as complete
- Sync
- Review parent budget
- Mark parent budget as complete.

Unlinking a child from a parent

If you realize you have selected the wrong proposal as a child proposal in a hierarchy:

- First make sure that the parent proposal budget is marked incomplete.
- Then open the child proposal in Edit mode.
- From the Edit menu, select “Remove from Hierarchy”.
- The child will then be removed from the parent.
Unlinking or breaking the entire hierarchy

To remove all child proposals from a hierarchy, follow the instructions for unlinking and unlink all proposals.

NOTE: If you unlink all child proposals from a hierarchy, the parent will completely disappear—it is deleted and gone for good. The only way to “bring back” a parent after all children have been unlinked from it is to create the hierarchy again: select one of the children to create the hierarchy with, go to the Edit menu and select “Create Hierarchy”. Then open the new parent proposal (it will have a new proposal number, different than the old proposal number) and link the other children to it.

Copying a proposal hierarchy

- Copy each child from the old hierarchy
- Create a new parent from one of the copied children and link the other copied children to the new parent
  - That is why it is better to upload narratives in the children, preferably child #1, than the parent.
- If you copy the original parent, it’s not a hierarchy anymore—it’s a stand-alone proposal
  - It’s ok if that’s what you want to do, but you will have to open the budget in modify mode and press sync for the rates table to be populated.

Special tips for various proposal hierarchy scenarios

A proposal has 2 or more co-PIs

- Each PI wants to see his/her budget separately
- List the PI just for that child in the investigator tab and just the budget for that PI in the budget screen.
  - Child 1: Professor A
  - Child 2: Professor B
- Parent
  - Parent Investigator tab lists all child PIs.
  - Parent Budget is summed for all child budgets.
  - Check off the lead PI on the Investigator tab

2+ departments are participating on 1 proposal

- See the “rights” section in this proposal hierarchy chapter

Sponsor pays different OH and/or EB on different cost elements

- Example: Sponsor pays 62% on some cost elements, 33% on others.
- Child 1 is for one OH rate
  - Budget includes only the cost elements for that OH rate
- Child 2 is for the other OH rate
  - Budget includes only the cost elements for that OH rate

What about on/off campus rates in one budget?

- In one proposal, you can select if a line item is on campus or off campus.
- Don’t have to use hierarchy
NIH K99/R00 proposals: How to make a proposal hierarchy when first 2 and last 3 years have different OH rates

K99 budgets are typically 5 year budgets. The first 2 years are at the 8% OH rate and the last 3 years are at the 62% OH rate.

Does your budget start on 7/1?

- Yes? You do not need to use hierarchy! Change the rates in the rates table in the budget.
  - OH & UR Rate type: “MTDC – custom”
  - In the rates table, scroll to the “MTDC –custom” section.
  - Change the first two years to 8%.
  - Change the last three years to 62%.
o No? If your budget starts any other date, then you have to use hierarchy. There will be 2 child proposals, one with a budget for the first two years and one with a budget for the last 3 years. The start and end dates for each of the child proposals will be for the entire 5 years, though.

- Create child 1. Even though this will be for the first two budget years, the start and end dates of the proposal are still 5 years: 9/1/17-8/31/22 for this example

- Specify the student and the faculty member on the Investigator and Key Person tabs as appropriate.
• In the budget for child 1, choose MTDC-custom for both OH and for UR rate types.

• In the rates button on the second toolbar, change the "MTDC-custom" percentage from 0% to 8% for the fiscal years involved with the first 2 budget years. In this example, the first two years budget years cross three fiscal years (2018, 2019, and 2020). Click OK and Yes.
• If you’re submitting via s2s, do you want the Base Salary to appear on the Detailed R&R Budget form or not? Base Salary will print as $0 by default, and is not a mandatory field. If you want Base Salary to appear on the Budget form:

1. Click on the running guy
2. Scroll to the right
3. Enter the calc base salary that Coeus will use in its red baron calculations
4. If you want the Base Salary to appear on the R&R Detailed Budget Form Base Salary box, manually enter the amounts here. Coeus will NOT use these values for calculations but the values will appear on the forms.
5. Click OK
Enter budget items, generate and save.
Now there are 5 years, but you only want budget items in the first two years.

Manually delete all items out of periods 3 through 5 so they are blank.
Use the delete button in the second toolbar to delete non-personnel costs.
Use the red baron to delete personnel costs, then use the delete button to remove the line item.
- At this time, mark the budget as final and complete, if you wish. Or you can mark it as Final but incomplete or final and complete. Negative underrecovery is ok. Save.

- Create child 2 for the budget (it will have a different proposal number from child 1). I highly recommend copying child 1 (but not the budget and not the narratives) so that the start and end dates are the same for both proposals, all 5 years.
- In the budget for child 2, keep the default MTDC for both the OH and for UR rate types, since it's 62% OH.
Go to the Budget Periods menu, Adjust Period Boundaries item.

The Define Periods window then opens.
- Delete the first 2 periods, just leaving the last three years. Note the overall budget start and end dates are still 5 years, but just the last 3 periods (3 years) will be in this budget.

- Click OK and then click Yes to syncing.
- Even though the first tab is labeled as “Period 1”, it is really “Period 3”.
Enter the cost elements and costs for year 3 in the “Period 1” tab. Generate. Periods 2 and 3 (corresponding to years 4 and 5) will appear. Make changes as necessary.

Change the Eff Date to the start date of the third year. Enter the Calc Base as of the start date of the third year. Do not enter anything in the the Base Salary_p1 through p5 boxes. Click OK.

Enter costs and generate
At this time, mark the budget as final and complete, if you wish. Or you can mark it as Final but incomplete or final and complete. Save.

Open Child 1 in Edit mode.
- The hierarchy HAS to be created from child 1
- Do NOT create the hierarchy from child 2

From the Edit menu, choose Create Hierarchy
• It will tell you what the proposal ID is for the parent. Write down that number.

• Open child 2 in Edit mode.
• From the Edit menu, choose Link to Hierarchy.

• Select "sub budget" from the pop-up box that appears.

• Then enter the parent proposal number in the search box.
Click OK. If your child does not have a final budget version marked, you will see a message letting you know the latest version will be used. Then click yes.

If you were successful, it will tell you the child has been linked to the parent.

Now you can open the parent and go to the budget there. You'll see the first 2 years at 8% and the last 3 at 62%. Check out the total tab as well.

The first 2 years are at 8% and the last three years are at 62%.

Also, when you are done you can mark your parent proposal budget as complete (by default, the parent budget is always marked as Final).
If you need to make changes to the child budgets:

- If you marked the parent budget as complete, you'll have to change that to incomplete first.
- Then open the child proposal in edit mode, and open the budget in edit mode. Change the status of the budget from complete to incomplete.
- Make the changes you need to make in each child.
- Mark the budget as complete in each child.
- Press the Sync button in the second toolbar. This will then sync your budget changes to the parent.
- It's probably best to do a final sync in your parent budget as well, before you mark the parent budget as complete. That will sync changes from both child proposals into the parent proposal.
- Mark the parent budget as complete.

What about everything else (narratives, YNQ, certifications):

- You can upload all narratives in child 1, not in the parent.
- You will answer the Yes/No questions in the parent, not the child proposals.
- You will certify the investigator in the parent proposal, not the child proposals.
- If you have special review information, enter them in child 1.
- If you're doing s2s, make the Grants.gov connection in the parent proposal, not the child proposals.
How to make a proposal hierarchy with different OH or EB rates for cost elements

Sometimes a sponsor will pay different OH or EB rates depending on the cost element. Let’s say in one proposal, there will be domestic travel, reprints, foreign travel, faculty summer salary and a research assistant. The sponsor will pay the following:

1. The standard 62% OH rate will be paid on domestic travel, reprints, and the research assistant. The standard EB rate will also be paid on the research assistant.
2. 33% OH will be paid on foreign travel
3. 25% EB and 40% OH will be paid on faculty salary

In this case, 3 child proposals need to be created, one for each of the cases specified above.

1. Child 1:
   a. Create child 1 for case 1, standard rates for domestic travel, reprints and the research assistant.
   b. Specify the investigator on the investigator tab.
   c. In the budget for child 1, since the OH and EB are the standard rates, you don’t have to change the MTDC or EB rates.
   d. Enter the cost elements and costs for period 1, generate, and adjust in remaining periods as necessary. In the description, you can include that these are at the standard rates (it will be easier to understand later).
   e. If you are ready, you can mark the budget as final and complete; otherwise leave it as final and incomplete, or just incomplete. Save.

2. Child 2:
   a. Create child 2 for the budget with 33% on foreign travel (it will have a different proposal number from child 1).
   b. Specify the investigator in child 2.
   c. In the budget for child 2, change the OH and UR Rate Types on the Summary tab in the Budget to “MTDC –custom”.
   d. Press the Rates button in the second toolbar. Scroll down until you see “MTDC-Custom”. Change the On campus rate from 0% to 33% for each fiscal year.
   e. Enter the foreign travel costs. Specify “33% OH” in the description line (it will help for later) and generate periods. Adjust values in outlying periods as necessary.
   f. If you are ready, you can mark the budget as final and complete; otherwise leave it as final and incomplete, or just incomplete. Save.

3. Child 3:
   a. Create child 3 for the 25% EB and 40% OH will be paid on faculty salary case (it will have a different proposal number from child 1 and child 2).
   b. Specify the investigator in child 3.
   c. In the budget for child 3, change the OH and UR Rate Types on the Summary tab in the Budget to “MTDC –custom”.
   d. Press the Rates button in the second toolbar. Scroll down until you see “MTDC-Custom”. Change the On campus rate from 0% to 40% for each fiscal year. In the example below, I changed just the On campus rate, but if there will be an Off campus rate for your proposal, please change it there.
   e. Keep scrolling through the Rates section until the “Employee Benefits Research Rate” section. Change the rate from the standard default rate to 25% for each fiscal year.
   f. Enter the faculty summer salary costs. Specify “40% OH and 25% EB” in the description line (it will help for later) and generate periods. Adjust values as necessary.
   g. If you are ready, you can mark the budget as final and complete; otherwise leave it as final and incomplete, or just incomplete. Save.

4. Now let’s have Coeus create the parent and then let’s link all 3 children together.
a. Open Child 1 in Edit mode.
b. From the Edit menu, choose Create Hierarchy
c. It will tell you what the proposal ID is for the parent. Write down that number.
d. Open the parent in in Edit mode.
e. From the Edit menu, choose Link Child Proposal.
f. Select Sub Budget.
g. Enter Child 2’s proposal number in the search box, click Find.
h. Highlight it in the search results list, click OK.
i. Coeus will then say it is linked.
j. Go back to the Edit menu and choose Link Child Proposal again.
k. Select Sub Budget.
l. Enter Child 3’s proposal number in the search box, click Find.
m. Highlight it in the search results list, click OK.

n. Coeus will then say it is linked. Now all three children are linked to your parent!
o. Now you can open the parent and view the budget there. You'll see the three child budget cost elements in each period, one after the other. Because you labeled the description with OH and/or EB rates, it’s easy to see which line corresponds to a particular child.
p. Check out the Budget total tab as well. You will see the OH-MTDC line for the 62% OH. There is also one line for “OH-MTDC-custom” which combines the 40% OH rate on the faculty member and the 33% OH Rate on the foreign travel together. The EB line combines the standard EB rate for the research assistant with the 25%EB rate for the faculty salary.

If you need to make changes to the child budgets:
• If you marked the parent budget as complete, you'll have to change that to incomplete first.
• Then open the child proposal in edit mode, and open the budget in edit mode. Change the status of the budget from complete to incomplete.
• Make the changes you need to make.
• Mark the budget as complete.
• Press the Sync button in the second toolbar. This will then sync your budget changes to the parent.
• It's probably best to do a final sync in your parent budget as well, before you mark the parent budget as final and complete. That will sync changes from both child proposals into the parent proposal.

What about everything else (narratives, YNQ, certifications):
• You can upload all narratives and special review information in the child proposals, preferably child #1. Do not upload narratives in the parent.
• Answer the Yes/No questions in the parent, not the child proposals.
• Certify the investigator(s) in the parent proposal, not the child proposals.
• If you’re doing s2s, make the Grants.gov connection in the parent proposal, not the child proposals.

What if the sponsor pays only part of the benefits, and the department is cost sharing the remainder of benefits, and at the same time is paying OH on some cost elements and no OH on others?

Sample proposal conditions: In this example, the sponsor is paying 20% TDC on some cost elements and no OH on others. Also, there is a cap on Employee Benefits (EB) of $5000. The remaining EB (difference in the normal, current EB rate) needs to be cost shared, and you'll need to provide the department source for this. (An alternative is the sponsor is paying 25% EB (a percentage) instead of a flat rate ($5000). How to handle this alternative is shown in red italics below).

What to do?? You’ll need to set up a proposal hierarchy with two child proposals, and then create the parent. If you’ve never done proposal hierarchy before, the important concept to understand is the children are created first, then the parent (this is the opposite of the pre-Prime award module, where the parent is created first, and then the children). Any changes to the budget are made to the children, then synced to the parent.
Let's create the children first.

**Child 1:**
- This is your first child proposal. This proposal will have 20% TDC, so on the budget summary tab, change the “OH Rate Type” and “UR Rate Type” to “TDC – custom”.
- Then click on the Rates button (% sign icon) in the second toolbar. Scroll to “TDC – custom” and change the rate from 0% to 20% for every fiscal year (be sure to keep scrolling to see every fiscal year).
- While you’re still in the Rates table, scroll to “Employee Benefits Research Rate” and change the benefits rate to 0%. *(If your scenario is the alternative example where the sponsor is paying 25%EB, change the benefits rate to 25% here)*.
- Enter all cost elements that have the 20% TDC overhead rate. Start each description with “20% OH” so as to make it easier to distinguish items in the parent budget later. *(This might not make sense now, but it will later.)*
- You will see negative underrecovery, which is fine. *(It’s positive underrecovery that’s a problem.)*
- Generate periods and make any necessary changes.
- In the summary tab, Comments box, type comments to explain the situation, something such as “20% TDC overhead. Sponsor is paying $5000 EB as shown in the other child proposal” and anything else you wish to record. Adding detail here is great. *(If your scenario is the alternative example where the sponsor is paying 25%EB, you can write: “20% TDC overhead. Sponsor is paying 25% EB as shown in this proposal. Remainder of benefit is cost shared as shown in the other child proposal.”)*
- If you’re done with the budget, mark it as final and complete.
- Upload your narratives in child 1.
- Do not answer YNQ, do not certify, do not enter special review. You’ll do those things in the parent.
- If you’re doing s2s you'll make the Grants.gov connection in the parent, not in the child proposals.

**Child 2:**
- Start another proposal (you can copy child 1, but not copy the budget). This proposal will be 0% OH, so on the budget summary tab, change the “OH Rate Type” and “UR Rate Type” to “TDC – custom”. The default rate for “TDC custom” is 0%, so no changes need to be made in the rates screen.
- Enter all cost elements that have the 0% overhead rate. Start each description with “0% OH” so as to make it easier to distinguish items in the parent budget later.
- Now it’s time to enter the $5000 in EB the sponsor will pay. Enter FRINGE - Fringe Benefits cost element. Enter $5000 as the cost to sponsor (if just one person. If 2 people, enter $10,000, etc). The Description can be “0% OH – flat EB paid by sponsor”. Double click on the line item. Enter the difference between the $5000 and the standard overhead rate into the “cost sharing” box. *(If your scenario is the alternative example where the sponsor is paying 25%EB, you can skip this bullet point. The 25% benefit was already entered and calculated in the first child proposal.)*
- Next step is only if your scenario is the alternative example where the sponsor is paying 25%EB, add the FRINGE line and double click on it. The cost box will be $0 since it was calculated in child 1. Enter the difference between the 25% and the standard EB rate into the “cost sharing” box. You will have to have done the calculation in Excel.
- Generate periods and make any necessary changes to cost and cost share.
- In the summary tab, Comments box, type comments to explain the situation, something such as “0% overhead. Sponsor is paying $5000 EB per person per year. Dept xxx (where xxx is the unit picking up the costs) is picking up remainder of employee benefits.” Any other special scenario can be explained here.
- Go to the Edit menu and distribute the cost share amount as usual.
If you’re done with the budget, mark it as final and complete.

Upload your narratives in child 1. It is easier to keep track of them and if you have to copy the hierarchy, you will copy the children and thus your narratives will be copied too.

Do not answer YNQ, do not certify, and do not enter special review here. You’ll do those things in the parent.

If you’re doing s2s you’ll make the Grants.gov connection in the parent, not in the child proposals.

The parent:

Now you’ll create the parent.

Open child 1 in edit mode. Go to the Edit menu, select “Create Hierarchy”. Coeus will then display the parent proposal number. Write down that number.

Close child 1. Open child 2 in edit mode. From the Edit menu, select, “Link to Hierarchy”. Coeus will ask you if you want to create a “Sub Budget” or “Sub Project”. Select “Sub Budget”.

Coeus will then ask you to enter the parent proposal number. Once you’ve entered the number, then pressed OK, the children will both be linked to the parent.

Open the parent in edit mode, open the budget screen and you will see your combined budget, with line items at 20% and others at 0%. If it all looks correct, set the budget to final and complete status.

- In order to set the budget to complete status, you might have to close the budget screen, then press the Budget button again and set the status to complete from the “select budget” screen.
- If the parent budget is not correct you will have to go back to each child in edit mode, change the status of the budget to incomplete, make the changes to the budget, and set the child budgets back to complete, then go back to the parent, press the SYNC button in the second toolbar, then review the parent budget again.

Certify the PI, answer YNQ and, if required, enter special review data.

Narratives should have been uploaded in the children, not in the parent.

If you’re doing s2s, make the Grants.gov connection in the parent proposal.

Then save and submit the parent for approval.

**Bug with syncing proposal hierarchy proposal and s2s Grants.gov applications**

If you're doing a proposal hierarchy s2s Grants.gov application, sometimes the detailed or modular budget forms do NOT have the overhead section filled in even though you can see the IDC in Coeus. For example, the detailed budget form, section H, appears as follows:

<table>
<thead>
<tr>
<th>H. Indirect Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indirect Cost Type</td>
</tr>
<tr>
<td>Cognitive Federal Agency</td>
</tr>
<tr>
<td>(Agency Name: POC Name: and POC Phone Number)</td>
</tr>
</tbody>
</table>

If the proposal is submitted as such to the Commons, it *will* error out with this error message:

<table>
<thead>
<tr>
<th>ERROR</th>
<th>The total cost requested for Budget Period 1 must be equal to the direct costs plus the indirect costs requested for that budget period.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR</td>
<td>The total cost requested for Budget Period 5 must be equal to the direct costs plus the indirect costs requested for that budget period.</td>
</tr>
<tr>
<td>ERROR</td>
<td>The total cost requested for Budget Period 3 must be equal to the direct costs plus the indirect costs requested for that budget period.</td>
</tr>
<tr>
<td>ERROR</td>
<td>The total cost requested for Budget Period 4 must be equal to the direct costs plus the indirect costs requested for that budget period.</td>
</tr>
<tr>
<td>ERROR</td>
<td>The total cost requested for Budget Period 2 must be equal to the direct costs plus the indirect costs requested for that budget period.</td>
</tr>
</tbody>
</table>
According to MIT, this bug seems to be triggered by syncing the hierarchy from within the budget screen and then clicking save.

Please check the Indirect Costs section of your detailed or modular budget forms right before you submit the proposal for approval. If the indirect costs are not printing, go to the parent proposal and sync it from the sync button in the second toolbar outside of the budget, and print the budget form again. The indirect costs section should then appear and you can submit the proposal for approval.
The University Research Board (URB) Process

Proposals that meet University Research Board (URB) readership criteria are sent to the URB for review, after ORPA submits the proposal to the sponsor. The URB criteria means the proposal meets one or more of the following conditions:

- Over $5 million in total costs (Automatically flagged in Coeus if the total Coeus budget is over $5 million and the proposal type is new)
- Biosafety level 3 handling (Automatically flagged in Coeus if the answer to YNQ P1 is Yes and the proposal type is new.)
- Countries embargoed or restricted (Automatically flagged in Coeus if the answer to YNQ P2. is Yes and the proposal type is new)
- Unusual proposal (As determined by the ORPA GCA)

Proposals that meet URB criteria are assigned by the Senior ERA Manager to two URB faculty committee members: one from humanities or social sciences and one from engineering or natural sciences.

If a URB reader has questions, the Senior ERA Manager sends the questions anonymously to the PI. When the PI responds, the Senior ERA Manager sends the response to the URB reader.

If the URB reader has further questions, the process is repeated until either the URB reader approves or the PI is invited to present the proposal at a URB meeting.

After the URB readers approve, the Coeus Proposal Development proposal status changes from "Post-submission approval" to Submitted.

If the URB rejects, the Coeus Proposal Development proposal status changes to Post-submission Rejection. The proposal would be withdrawn from the sponsor.
Additional Functionality

Adding a Name to the Rolodex

You can add a name to the rolodex....

• If the person is a non-Princeton person & needs to be added to the Investigator or Key Person tab (because they will be at Princeton but are not here yet and are not in the Princeton person search, or the person is an investigator at another school and you're submitting s2s)
• If your dept loves to print the generic cover page, and the person you are submitting to is not already in the rolodex.

Be sure to check the person doesn't already exist in the rolodex before adding them

• You can edit rolodex entries if you need to.
Adding Coeus Roles/Adding Coeus rights: Granting View/Update Access to Your Proposal

If you need to give someone access to a proposal on a case-by-case basis

• You can assign that access yourself
• You can assign view only or update access
• You cannot assign or change Approvers (email coeus_help@princeton.edu if the approvers need to change).

If you get a new person in the dept and they need access to proposals going forward

• Fill out the Coeus new user request form (on the Coeus home page) and send it to coeus_help@princeton.edu
Granting access

To add a person to a role, click on their name (under Users on the left) & drag their user name to the Role name (so the role turns blue). Click OK, then click Save.

Aggregator is someone who can edit a proposal, including submitting it.

Viewer means they can just view. You cannot add Approvers.
What do the different roles mean?

"Roles" displays the roles a person has for this proposal.

To see what rights are in a role, click on the role name and then the rights button.
Email notification

You can send email through Coeus if you want to....

- Some people love it (it includes the proposal #, title, PI, deadline date by default, plus your comments)
- Others never use it (you can just use Outlook instead; Coeus mail does not have a Sent box so unless you include yourself, you don't have a record of what you sent)
Select recipients with the "Add Person" button. You can select multiple recipients.

Type in the subject line you want the email to have.

Type in the Message Body with the text. Other standard default text will be added to the email that is sent.

NOTE: Coeus does not have a "sent" folder so if you want a copy of this mail you will have to add yourself in the "Send To".

You don't have to use Coeus mail—you can use Outlook if you prefer.

Be sure to sign your mail with your name. The email is sent from coeusadm@princeton.edu, not from your personal account.
Proposals where the Data Override Feature was used (the proposal development number is in red)

If the proposal # box is in red, that means your ORPA rep made a change to the proposal before they approved it

- ORPA reps can make minor changes to proposals that are "approval in progress" status.
- They can change the title, proposal type, add the deadline date, etc.
- The red Proposal No box indicates a change was made.
- Go to Edit > Data Override. Any field with an arrow means a change was made. Click on that row to see the "before" and "after" values.
Any row with an arrow means an update was made.

Click on that row to see the old and new values.
Viewing CITI RCR or FCOI Training Data in Coeus

You can view an individual person's training information in Coeus through the Person table, Training tab. Note that for RCR this will not show you which project this person is charged to, nor will you be able to view training data for more than one person in one screen.

For RCR, a person can be marked as needing training in Coeus if they are charged to a grant with the RCR attribute. If the person has taken the training, the date and method by which s/he completed the training will be indicated (CITI for online CITI training, the registrar’s course number if the course is a RCR course, or “external” if the person took RCR at another institution and that training is accepted by Princeton).

For FCOI Training, a person is only marked as having taken the training, not that they need to take the training.

Human subjects IRB training was tracked in Coeus until mid-July 2017, when this data was frozen in Coeus and the CITI feed was redirected to InfoEd (eRIA) instead. Please contact eRIA staff if you need to see IRB training since mid-July 2017.

1. Click on the "Maintain Personnel" button (AKA the shady guy) icon.

2. The Person Search window appears.

3. Enter the person's last name in the "last name" box
   a. Alternatively you search by "user name" if you'd like.
   b. You can use a star as the wildcard. So if you could type in just the first few letters of the last name, and then an asterisk, such as har* to find all users who have a last name beginning with Har.

   c. Find the person in the search results list.
4. Double click on his/her name, and the Person Details screen then appears.

5. Click on the Training tab and look at the rows:
   a. For RCR Training:
      i. If Date Requested is filled in but no other data is filled in, the person has been marked as needing RCR training because they were charged to an award with the RCR attribute in PS Grants.
      ii. If the Date Requested, Date Submitted and Score are filled in, the person has taken the RCR training.
         1. Date Requested is the date the data was entered/fed into Coeus.
         2. Date Submitted is the course completion date
         3. Score is the method of RCR training completion
            a. A Princeton course code
            b. CITI if they took the online CITI training
            c. EXTERNAL if the training was taken at a visiting student's home institution, or a post-doc's graduate school.
      iii. Date Acknowledged and Followup Date will always be blank.
   b. For IRB Training:
      i. NIH IRB training:
1. The "Date Requested" is the date they completed the NIH IRB training. All other columns will be blank.

ii. For CITI IRB training (mid-July 2017 or prior; please see eRIA for CITI IRB training taken after that date):
   1. The "Date Requested" is the date the training info fed from CITI to Coeus.
   2. "Date Submitted" is the date the person completed the CITI IRB training.
   3. Score is CITI
   4. Other columns are blank.

i. For CITI FCOI Training:
   1. The "Date Requested" is the date the training info fed from CITI to Coeus.
   2. "Date Submitted" is the date the person completed the CITI FCOI training.
   3. Score is CITI
   4. Other columns are blank.
Institute Proposal Module

The Institute Proposal number (IP) is assigned when the Proposal Development proposal has been approved by ORPA. This module includes proposal status information:

- **Pending**: proposal has been submitted to sponsor; waiting to hear back from the sponsor about their decision (this can take months or sometimes even years)
- **Funded**: sponsor funded the proposal
- **Already awarded**: same as funded; this status is used to get around a Coeus bug that occasionally doesn't let ORPA label the proposal as Funded.
- **Declined**: sponsor rejected the proposal.
- **Inactive**: this status is really reserved for mistakes, since we cannot delete IPs from Coeus.

Unless ORPA is told a proposal is declined, the IP status remains as pending and the proposal will appear on the "current and pending" report in Coeus and in the Information Warehouse as pending. If you are notified that a proposal is declined, please tell your ORPA rep so that s/he can change the status to declined. Once the proposal is marked as declined, the proposal will then fall off the C&P the next day.

**Searching the Institute Proposal Module for pending proposals**

As a department user, you are probably most interested in seeing which proposals are still pending for your dept.

Click on the institute proposal button.

The "Select Proposal" screen appears. From the Status pulldown menu, select Pending and click on Find.

A list of all pending institute proposals for your department appears. Double click on any of them to view them. If any are listed a spending but should be listed as declined, please notify your ORPA rep so that ORPA can change the status to declined.
Printing the Pending proposals report through the Institute Proposal Module

You can print the pending proposals report through the institute proposal module, or you can print the FIN063-Current and Pending report in the IW.

The pending report in Coeus is real time and can be saved as an Excel spreadsheet, but the format is funky and includes fields (like % effort) that are not used in Coeus.

The FIN063 - Current and Pending report in the IW is day-old data, but it is probably closer to the format you want. It also can be saved to Excel.

There are two ways to run the Pending Support out of Coeus. Here is the fastest way, which saves it as an Excel spreadsheet. You can run the Pending support on any PI; the PI and his/her proposals do not need to be in your dept.

Click on the Maintain Personnel button (the shady guy icon)
The Search box then appears. Search on the person's name and press Find.

Click on the person's name in the search results list.

From the Edit menu, select "Current and Pending Report"
Open your excel spreadsheet

Now you have your pending data for that person.
Note: You cannot save the "current support" out of Coeus as it reflects the current support when Coeus was frozen in mid-June 2014. You must use the FIN063 – Current and Pending Support report in the Information Warehouse instead.
Using Medusa: Linking various tracking numbers

Pre-Prime: Tracking numbers were automatically assigned by Coeus at the following stages. You could look up one number (for example, the subaward number) and find all numbers linked to it with Medusa (the award, PD proposal and IP proposal numbers.)

• When the dept started a Coeus proposal development (PD) proposal, a Coeus tracking number was generated.
• When the ORPA rep approved the PD proposal, the Coeus Institute Proposal (IP) number was generated.
• If awarded, a Coeus Award number (and PG #) was generated when the ORPA Award Specialists funded the award.
• If the award had subawards, a Coeus subaward number was also generated when the ORPA Subaward Administrator added the sub in Coeus.

Post-Prime: The Coeus award and subaward modules are frozen as of mid-June, 2014. Since that date, tracking numbers are assigned as follows:

• When the dept starts a Coeus proposal development (PD) proposal, a Coeus tracking number is generated.
• When the ORPA rep approves the PD proposal, the Coeus Institute Proposal (IP) number is generated.
• If awarded, the ORPA Award Specialist interfaces the Coeus IP proposal to PS Grants. The PS Grants award number is generated in PS and then feeds back to the Coeus IP module, in the Account number box, at 5am the next weekday morning. The interface also flips the status of the IP from “Pending” to “Funded”.
• If the award had subawards, a PS PO number is generated by the ORPA Subaward Administrator in PS Grants. This number does not feed back to Coeus.

Using Medusa to view the Coeus Proposal Development Narrative (attachments) when you have the Coeus Institute Proposal Number

This quick guide is for users who have the Coeus Institute Proposal number and need to view the Coeus Proposal Development proposal narrative.

Click here to search the Coeus IP module
If you know the proposal number, enter the IP # here.

You can use a * in place of the zeros.

Otherwise you can search by other criteria, i.e., Investigator name.

Highlight the proposal so the row is blue (if you searched for just one proposal the row will already be blue.)

Click on Medusa.
1. Click on the number next to the "colorful building blocks" icon.

NOTE: What if there is more than one row of colorful building block numbers? Start with the one at the bottom.

2. Now you are viewing the Coeus Proposal Development proposal. Click on the Narrative button.
Using Medusa to view the Coeus Proposal Development Narrative (attachments) when you have the PeopleSoft Award Number

PeopleSoft award numbers start with AWD (any award funded added after 7/1/14) or CNV (awards that were funded in Coeus and then converted to PS).

If you have the PS award number and need to view the Coeus narrative:

NOTE: When you are done viewing the narrative, use the yellow folder button in the second toolbar to close:

- The narrative screen
- The proposal development (PD) screen
- Medusa
- The Institute Proposal screen

If you don't close all these screens, & then look up another proposal with the Medusa button, it will display the proposal you previously searched for instead of the one you are currently searching on.
Click here to search the Coeus IP module.

Enter the PS award number in the Account Number box.

Press Find.

Click on Medusa.
Click on the number next to the "colorful building blocks" icon so that it's highlighted in blue.

What if there is more than one row of colorful building block number? Start with the one listed last.

Now you are viewing the Coeus Proposal Development proposal.
Click on the Narrative button.
Using Medusa to view the sponsor’s proposal status when you have the Coeus Proposal Development number.

NOTE: When you are done viewing the narrative, use the yellow folder button in the second toolbar to close:

• The narrative screen
• The proposal development (PD) screen
• Medusa
• The Institute Proposal screen

If you don't close all these screens, & then look up another proposal with the Medusa button, it will display the proposal you previously searched for instead of the one you are currently searching on.

Using Medusa to view the sponsor’s proposal status when you have the Coeus Proposal Development number.
You have the Coeus Proposal Development number and want to know if the proposal is Funded by the sponsor, Declined by the sponsor, or still pending the sponsor's decision.

Click on the Proposal Development icon.

1. Enter the Coeus Proposal Development number in the Proposal Number box.

(Instead of entering 00019380, you can use "*19380, where the * takes the place of the zeros).

2. Click Find

Click on Medusa
Click on the number next to the "two pieces of paper" icon

2

This is the sponsor status:
Funded or Already Awarded (means the same thing)

Declined (sponsor declined the proposal)

Pending (still waiting to hear back from the sponsor if they will fund it or not).
Subaward Module

Subawards and Coeus

- Pre-Prime, the Coeus subaward module was used for tracking subawards.
- There was a period of time that CAs and PSPAs and later ICAs were tracked in the Coeus subaward module, but that was assumed by the purchasing dept before Prime go-live.
- Subaward invoices were uploaded in Coeus from 12/22/08 through mid-June 2014.
- Subaward invoices prior to 12/22/08 were entered into ORPA OnBase.
- The Coeus subaward module was frozen shortly before Prime go-live on 7/1/14.
- Subaward invoices prior to 6/20/14 will remain in Coeus.
- Subaward invoices approved in Coeus prior to 6/20/14 will remain in Coeus.
- The PDFs of the invoices were not converted to PeopleSoft.
- Those pre-Prime invoices do not appear on the FIN030 - Subaward Detail Report and FIN031 – Subaward Invoice Drill.
- You can still view all the data above in the Coeus subaward module.
- Post-Prime, all subawards are entered in PS Financials. The FIN030 – Subaward Detail Report and the FIN031 – Subaward Invoice Drill in the IW should be used to view subaward data instead of Coeus. Those reports contain one-day old data.

Viewing subaward invoices entered in Coeus between 12/22/08 and 7/1/14

To view old subaward invoices that were entered in Coeus between 12/22/08 and 7/1/14:

1. Search on the subaward number (or other criteria).
2. Use the * in place of zeros.

3. Click Find.
The table of statuses for subaward invoices is below. At Prime go-live, most invoices were either “Approved” or “Rejected”. Older invoices may have no status or a status of “in progress”. This is because they were entered into the system years ago using a different procedure. Generally, these older invoices (unless you see a second line with a negative amount to “back the money out”) can be considered to be approved.

<table>
<thead>
<tr>
<th>Status</th>
<th>Status Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Progress</td>
<td>If the invoice is new, the invoice has been entered into Coeus by an ORPA coordinator, but the email has not been sent to the PI for approval.</td>
</tr>
<tr>
<td>Sent</td>
<td>The invoice has been entered into Coeus and email has been sent to the PI indicating there is a subaward awaiting approval.</td>
</tr>
<tr>
<td>Approved</td>
<td>The invoice has been approved.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The invoice has been rejected. This line appears in red.</td>
</tr>
<tr>
<td>Rejection Approved</td>
<td>This is the second line that is added to “back the money out” of subaward invoices that were rejected. It is equivalent to the negative amount of money for the invoice. This line appears in red.</td>
</tr>
</tbody>
</table>

**NOTE:** The “Last Updated by” line may not make any sense for invoices entered since 12/22/08 and can be ignored.
Pre-Prime awards, award budgets, and Coeus

- Pre-Prime, the Coeus award and award budget modules were used for tracking awards and award budgets.
- The Coeus award and award budget modules were frozen shortly before Prime go-live on 7/1/14.
- You can still view all the award and award budget data for your dept in the Coeus award and award budget modules.
- Awards that were active in FY14 and any closed children associated with active parents were converted from Coeus to PS at Prime go-live.
- What was not converted?
  - The history of every increment and budget
    - The current cumulative amounts (obligated dollars, dates and budget) were converted
    - Anticipated totals and end dates were converted
  - All comments on the Comments tab were not converted
  - All attachments on the Attachments tab were not converted
  - Not every term was converted (terms were condensed at conversion)
  - Payment schedule was not converted
  - All Institute Proposal numbers funding the award were not converted
    - Only the initial IP number was converted
- Post-Prime, all awards and award budgets are entered in PS Financials. The reports in the IW > University Financials – Prime > Sponsored Research folder should be used for viewing award and project budget data. All reports in the IW contain one-day old data, except the NOA which is real-time.

Viewing pre-Prime awards entered in Coeus prior to 7/1/14 (Printing the Pre-Prime NOA)

The easiest way to view old Coeus award information is by printing the pre-Prime NOA out of Coeus. The NOA summarizes the information on each Coeus award tab.
<table>
<thead>
<tr>
<th>Number</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sponsor Award Number</td>
<td>The award number given by the sponsor.</td>
</tr>
<tr>
<td>Award Number</td>
<td>This is the Coeus assigned award number, which is a sequential number. If the number ends in -001, (i.e. 001234-001) it is a parent account or the only account associated with this award. If this number ends in any other number (i.e. 001234-009), it indicates this award is a child, grandchild, or perhaps even a great-grandchild.</td>
</tr>
<tr>
<td>Account Number</td>
<td>This is the 7 digit Project/Grant number, such as 1954. It starts with the three digit unit number and ends with a 4 digit number. If the 4 digit number begins with a 4, the sponsor is a non-government sponsor. If the 4 digit number begins with a 6, the sponsor or prime sponsor is a government sponsor. If the 4 digit number begins with a 3, it's an internal cost sharing account. Please note that 2000 accounts are not stored in Coeus. Do not use the dash when searching on PG account numbers; Coeus doesn't understand the dash in this field.</td>
</tr>
</tbody>
</table>

The list of search results will appear. Double click on the line you would like to view. (Note, you can only view awards for the departments in which you have the “View Award” right.)
Viewing pre-Prime award attachments uploaded in Coeus between 7/12/10 and 7/1/14

The July 2010 upgrade added the functionality for Award Specialists to upload award attachments from that point forward. Those attachments were not converted out of Coeus to Prime.

To view the attachments, follow the steps as for printing the NOA in the section above, but instead of clicking on the Printer icon, click on the Attachments tab instead. Then click on the PDF icon for the document you want to view.
The PDF of the NOA will open either in a tab in your browser window or in Adobe. From that separate window, the NOA can be printed or saved.

**Viewing cost sharing in a pre-Prime Coeus award**

As of the fall of 2010, awards with cost sharing have child accounts specifically set up for cost sharing. Cost shared child accounts are Fund 30 accounts, or 3000 accounts.

You can easily view an award hierarchy in Coeus by searching on the Coeus award number (i.e. *7212* in the "award number" box), which will return the entire hierarchy in the search results screen. (In this case, do not search on the "account number" box, which is for project/grant numbers—you could, but it can be tedious to enter all PG numbers in a hierarchy).

Double click on the cost sharing account in the search results to view it. It will have a 3xxx account number and the sponsor name will include "Princeton Internal Cost Sharing".

- 260 -
To view cost sharing details, from the Details menu, select Cost Sharing.

The Cost Sharing screen is then displayed.

- Percentage is not used.
- Type is the cost sharing type.
- Source and destination accounts are listed.
- Amount is the cost sharing amount.
1. Depending on how your machine is set up, the PDF of the NOA will open either in a tab in your browser window or in Adobe Acrobat Professional. (To change where you want the Coeus-generated PDF to open, please see the last chapter of this manual). From that separate window, the NOA can be printed or saved.

**NOA:** While the font and spacing of the NOA has changed with 4.4, the content has remained the same.

**Viewing a pre-Prime Award Budget**

Pre-Prime award budget data was entered by the ORPA Award Specialists; award rebudgets were generally done by the dept.

- With the award already open in view mode, click on the Money and End Dates tab, then click on the Budget button on the right side of the screen.
- The Budget window will open. Any budget amounts of zero were rebudgets (i.e. money moved from one (or more) cost element(s) to another.)
- 263 -

- Highlight the line you wish to view and then press the Display button.

- Use the scroll bar on the right side to view cost elements that may not fit on the screen at one time.
- Press Close to close the window.
NOTE: If Coeus asks you if you want to save changes after you viewed an award budget, the answer is NO! It's a Coeus bug and it shouldn't ask you this question. If you answer yes, it will change the last user, date and timestamp to *your name and today's date*. Please, just say no!
# Coeus Bugs Quirks list

_Coeus 4.5.1.P2 bugs and quirks list, Updated March 2016_

This list contains Coeus quirks, bugs, and FYIs. It contains all bugs reported in the Coeus Proposal Development Guide. CoeusLite Proposal Development quirks are listed at the end of this document.

s2s bugs are in a separate doc.

For all info about Java and Coeus Premium, see the [Coeus installation and troubleshooting guide](#).

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
</table>
| Locked Proposals (locked by your account) | If you try to open your proposal in edit/modify mode, but Coeus won’t let you because the "proposal is locked by <your name>“, you can unlock the proposal yourself.  

- First, go to the Window menu and see if the proposal is listed at the bottom of that list—if it is, then you already have the proposal open and can just click on the proposal number in that list to go back to that window.  

If the proposal is not in the Window menu list, then from the File menu, choose “Current Locks”. You will then see your proposal ID in the list. Select the proposal by clicking on it once to highlight it in blue, then click on the Unlock button. Repeat for however many times your proposal is listed in the locked list. You will then be able to edit your proposal. | 3/29/16 |
| Locked Proposals (locked by someone else’s account) | If you try to open your proposal in edit/modify mode, but Coeus won’t let you because the "proposal is locked by <someone else’s name>“, you will have to ask that person to unlock the proposal by closing it. If they do not have Coeus open, you can ask the person to unlock it according to the instructions above, or, if that person is not available, you can contact the Coeus Hotline at 8-7373 to have it unlocked. | 3/29/16 |
| Copying proposals | If you have trouble copying a proposal, there could be a few reasons why. If you were not an aggregator on the original proposal, it will not let you copy the proposal | 10/29/09 |
and you will have to ask a coworker who was an aggregator on the original proposal to copy it for you and add you as an aggregator to the copy.

If you were an aggregator on the original proposal, there may be a corrupted, uploaded file in the narrative of the proposal you’re trying to copy. If it’s the latter case, usually Coeus will let you copy at least the budget.

On 4/16/09, the personnel names in all Coeus modules were updated to not include special characters (i.e. removing accents from characters). This will make searching for personnel names easier in all modules. This also helps us with the system-to-system Coeus to Grants.gov connection, since special characters cause submission issues for Grants.gov.

However, at that time, the PeopleSoft Primary name was pulled in instead of the PeopleSoft Preferred name. As of 5/14/09, the Preferred PeopleSoft name without special characters is being used.

**Coeus production server is rebooted** every morning at 5am. The reboot takes approximately 2 minutes, so Coeus will be down for that period of time daily.

Rebooting Coeus server

If you submit a proposal and get an error message about “no routing stops defined”, it means no budget has been entered at all. If your proposal has no budget, you still have to mark the budget of $0 as final and complete. Then you should be able to submit the proposal.

No Routing Stops defined

If you enter a search term on the first line of the search screen in any module, then want to enter a second number in the next row, you would expect that if you press the down arrow, the cursor would go to the next line. In Coeus, the cursor stays on the first line with the first press of the down arrow. You have to press the down arrow twice to get the cursor to move to the second line (or use your mouse to put the cursor on the next line). This problem only happens on the first line of the search screen.

Entering search terms

For the Proposal Development & Institute Proposal modules: When a search returns more than one search result, the proposals will be listed in reverse numerical order, so recent proposals/subcontracts will be listed first.

Search results order

Please upload your narratives in your child proposals, preferably child #1, instead of in the parent proposal. This is because if you need to copy the hierarchy, you have to copy the children and create the new parent from one of the copied children. By uploading the narratives in the children, they will get copied, saving you from having to upload them all over again. Also it may be easier to track your narratives if they are all in child #1.

Proposal hierarchy & narratives

<table>
<thead>
<tr>
<th>Personnel Names</th>
<th>5/27/10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebooting Coeus server</td>
<td>1/16/09</td>
</tr>
<tr>
<td>No Routing Stops defined</td>
<td>1/4/10</td>
</tr>
<tr>
<td>Entering search terms</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Search results order</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Proposal hierarchy &amp; narratives</td>
<td>11/5/12</td>
</tr>
</tbody>
</table>
“This is not a proposal person” message when certifying

If you try to certify a person, and Coeus says “This is not a proposal person”, remove the person from the Coeus Investigator tab, save, and add them back. Then you’ll be able to certify.

4/8/13

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uploading narrative files</td>
<td>ORPA is no longer able to upload any files, including the final version of the proposal, to Coeus after the proposal has been approved by ORPA, regardless of sponsor. Therefore, please be sure to upload all components of your proposal into Coeus before routing it for approval.</td>
<td>5/27/10</td>
</tr>
<tr>
<td></td>
<td>Please view all uploaded files in Coeus to verify that they can be viewed and are not corrupted, before you submit your proposal for approval.</td>
<td>1/12/09</td>
</tr>
<tr>
<td>Review narrative files in Coeus.</td>
<td>One user reported that Coeus crashes if she adds a narrative row, but then closes the module screen for that row, then uses the Edit button to open the narrative screen for that row, and then presses the Upload button. This happens for any proposal she works on. If this happens to you, the workaround is to add the narrative row, and press the Upload button while you are still in the narrative screen. Then you will be able to upload the narrative file without Coeus crashing.</td>
<td>8/19/10</td>
</tr>
</tbody>
</table>

General Proposal Development budget bugs/quirks

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td>TBA types and red baron</td>
<td>While you can load multiple named people into one cost element line in the red baron (i.e. two professors listed in the red baron on one cost element line for SALRF), each TBA person needs his/her own budget line. It's a confirmed Coeus quirk.</td>
<td>2/3/11</td>
</tr>
<tr>
<td>Topic</td>
<td>Description</td>
<td>Date</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>TBA types and job code in the red running guy</td>
<td>If there is more than one TBA person, and the TBA people are of the same “type” (i.e. two graduate students are TBA) make sure to change the “Job Code” to be different for each TBA person (i.e. TBA1, TBA2). That is the only way Coeus can determine the quantity of TBA people of that type.</td>
<td>2/3/11</td>
</tr>
<tr>
<td>Problems with Leap Year and the red baron, and budget months</td>
<td><strong>Problem 1:</strong> If you are using the red baron for a graduate student, breaking out the academic and summer months, and a subsequent year is leap year, when you generate your budget periods, double check the red baron in the period containing Feb of the leap year. Typically in the period that includes February of the leap year, the end date for the grad student in the red baron is 6/29 instead of 6/30. This leads to the loss of a day’s salary, and will appear on the Grants.gov form as, for example, 9.97 months instead of 10 months. You will have to manually correct the end date in the red baron for that period. <strong>Problem 2:</strong> Also, if you use the red baron for other person types and budget academic months, you may see that after generating periods, the person's end date may extend one day into the next month (i.e. 6/1 instead of 5/31) in the budget year containing Feb of the leap year. You will have to manually correct the end date in the red baron for that period.</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Changing costs appends rather than overwrites the previous cost.</td>
<td>Click once on the line item to select it, PAUSE, then click once into the cost box to change the amount. If you highlight the amount of money with your cursor, do not highlight the dollar sign and the amount. If you do highlight the dollar sign and amount together, any numbers you enter will be appended to the current amount instead of overwriting the amount. Avoid this by only highlighting the numbers (or using the delete or backspace key) and do not highlight the dollar sign.</td>
<td>12/22/08</td>
</tr>
<tr>
<td>Overhead and/or benefits are not calculating correctly (i.e. it’s not calculated for every budget year or only part of a budget year)</td>
<td>Inside the budget, press the Rates button (it's on the second toolbar and looks like a percent sign). Press the Sync button. Then save. The OH should now be calculated. The most likely cause for this problem is copying an old proposal or changing the dates on a proposal and not syncing the rates.</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Specifying the OH and UR rate type</td>
<td>If you change the OH rate type to something other than MTDC on the budget summary tab, please be sure to change the UR rate type on the budget summary tab to match the OH rate type chosen. Depending on the scenario, negative underrecovery may be generated, which is fine.</td>
<td>3/5/09</td>
</tr>
<tr>
<td>Negative underrecovery is OK!</td>
<td>When you change the OH rate type to something other than MTDC, please change the UR rate type to match. If you use “MTDC custom” or “TDC custom”, and change your rate to something other than the</td>
<td>4/22/09</td>
</tr>
<tr>
<td>How do I remove positive underrecovery?</td>
<td>default of 0% (in either “MTDC custom” or “TDC custom” in the Rates button), Coeus calculates the difference between 0% and whatever rate you chose, which generates negative underrecovery. Negative underrecovery is ok!</td>
<td>4/22/09</td>
</tr>
<tr>
<td>Copying proposals and budgets</td>
<td>First, don’t uncheck the OH or EB rate box for any of your cost elements—doing that will generate underrecovery. Second, when you need to change your rate to something other than 62% on MTDC, select the OH rate type on the Summary tab as “MTDC –custom” or “TDC –custom” as necessary. Change the UR rate type to match. Then in the Rates button (on the second toolbar), scroll down until you see the “MTDC –custom” or “TDC –custom” (whichever you chose) section. Note that there are lines for On and Off campus, for each fiscal year. Change the On and/or Off campus from the default of 0 to whatever the percentage should be, then save. You will see negative underrecovery, which is fine!</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Marking budget as complete with cost sharing</td>
<td>If you copy a proposal with a budget where the UR rate type is not MTDC, in the copy, the UR rate type defaults back to MTDC. You have to change the copy's UR rate type to match the OH rate type.</td>
<td>6/14/10</td>
</tr>
<tr>
<td>TBA types and job code in the red running guy</td>
<td>Sometimes when you are trying to mark a budget as complete, Coeus tells you that you need to distribute the cost sharing when you actually have already distributed the cost sharing. If the cost sharing values on the cost sharing distribution screen are correct, then close the budget screen (say no to saving), then click on the budget button and select &quot;Complete&quot; from the &quot;Select Budget&quot; screen instead. Then it should be ok.</td>
<td>2/3/11</td>
</tr>
<tr>
<td></td>
<td>If there is more than one TBA person, and the TBA people are of the same &quot;type&quot;(i.e. two graduate students are TBA) make sure to change the &quot;Job Code&quot; to be different for each TBA person (i.e. TBA1, TBA2). That is the only way Coeus can determine the quantity of TBA people of that type.</td>
<td>2/3/11</td>
</tr>
</tbody>
</table>
Budgets periods that are not always 12 months
(such as 7 budget periods in 5 years)

Description

- Make sure to adjust budget periods *before* adding the cost elements and generating.

- If your budget periods are 12 months and then 6 months, and you enter the 12 month salary for a person in the cost box without using the red baron, and then you generate, the 6 month cost for that person will not be half of what it was in the first 12 months (plus inflation). Instead it will be 4% more of the entire amount entered for the first 12 months. You will have to manually adjust the 6 month amount.

Budget Printing Quirks

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget forms in general</td>
<td>Sometimes if a particular category of cost elements has a lot of line items, and these line items happen to cross a page break, the program actually prints the total cost for that category of cost elements before <em>and</em> after the page break, which is confusing.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Long titles</td>
<td>Long titles are either truncated or run off the budget page.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Personnel</td>
<td>Occasionally, some or none of the personnel people print on the MIT budget forms, even if the red baron was used. It is not clear as to the conditions under which this happens for budgets created in 4.4. If a 4.2 budget is printed in 4.4., and the red baron was not used in the 4.2 budget, the personnel will not print.</td>
<td>5/27/10</td>
</tr>
</tbody>
</table>
### Cost sharing summary by period report

If you don't use the red baron for a personnel item and that item has cost sharing, the cost sharing amount won't appear on the line item for that person on the form, and won't be in the cost sharing total nor grand total cost of project for that form.

5/27/10

---

### COST SHARING

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributing cost sharing</td>
<td>In the budget, Edit, Cost Share Distribution window, the &quot;Source Account&quot; is the 5 digit department number that is picking up the cost sharing. If anything other than a 5 digit dept number is entered in this box, that cost sharing row will not print on the PU_CostShareReport.xsl report.</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Cost sharing in general</td>
<td>For more information regarding entering cost sharing in Coeus, please see the Cost Sharing section in the Coeus Proposal Development Guide. For more information about the revised cost sharing process, see the Cost Sharing links on this page.</td>
<td>4/22/09</td>
</tr>
</tbody>
</table>

---

### Quirks and error messages while submitting proposal for approval

<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock deleted by DB Admin</td>
<td>If you get the &quot;Lock deleted by DB Admin&quot; message when trying to submit, close Coeus, reopen Coeus and it should be ok.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Narratives are incomplete</td>
<td>If you copy a proposal and then try to submit it, Coeus states the narratives are incomplete, even though they are marked as complete. This is normal behavior; Coeus is asking you to confirm you really don't want to make changes to the narratives. However, sometimes when you start a brand new proposal from scratch, and you mark all narratives as complete, Coeus might tell you that the narratives are incomplete. You'll go back to the narratives section, see they are complete and try to submit again. Sometimes that is enough, but other times it will still continue to state the narrative is incomplete. We found that setting the status of one narrative from complete to incomplete, then changing it back to</td>
<td>5/27/10</td>
</tr>
</tbody>
</table>
### CoeusLite Proposal Development issues

<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Proposal is locked by your account</strong></td>
<td>If you try to modify a proposal and it says it is locked, click on the &quot;Current Locks&quot; link in the upper right corner, then click on each Remove link that you see. This will remove the lock on each part of the proposal and then allow you to continue working.</td>
<td>9/10/10</td>
</tr>
<tr>
<td><strong>Calculating person's salary</strong></td>
<td>Let's say you add a person to a CoeusLite budget, and instead of pressing save, you press calculate. CoeusLite then calculates the person's salary. When you add the next person, the calculated value for the previous person disappears, and doesn't reappear until you press save. This also happens anytime after pressing save and then entering another person's budget amount immediately.</td>
<td>12/20/10</td>
</tr>
<tr>
<td><strong>Modifying person's base salary after generating periods</strong></td>
<td>If you modify a person's base salary on the Personnel screen after having Coeus calculate the person's salary in periods, you have to go into each period for that person and press save on the Personnel Budget screen for <strong>EVERY</strong> period to get the salaries to recalculate--the salaries do not appear to be recalculated otherwise.</td>
<td>9/10/10</td>
</tr>
<tr>
<td><strong>Problem trying to change budget status from &quot;Incomplete&quot;</strong></td>
<td>This is an intermittent bug. Sometimes when the user selects Budget Status &quot;Incomplete&quot;, an error message is displayed that says &quot;An Error Has Occurred: No Message.&quot; If this happens, try marking the budget status as Complete from the Budget Versions window. This bug does not seem to occur there.</td>
<td>9/10/10</td>
</tr>
</tbody>
</table>

---

**Budget is incomplete**

Sometimes when you try to submit a proposal, Coeus will state that the budget is incomplete. You go to the budget and see the budget is actually marked as final and complete. The solution is to change the budget status from complete to incomplete and back to complete, and press save. Then you should be able to submit the proposal.

5/27/10
There's an intermittent cost sharing distribution bug in CoeusLite which MIT confirmed is a bug. Sometimes when the user divides cost sharing among several units, CoeusLite says the values don't add to the grand total for cost sharing, when they actually do add up. Other times it seems to work fine. If this happens, then Coeus Premium must be used to distribute the cost sharing amount.

Anytime there's a decimal quantity of months, it appears as a rounded number. In this example, the number of months should be 2.5 months based on start/end date and %charged/%effort, but it appears as 3.0. At least the detailed Grants.gov budget form lists this as 2.5!

After syncing the budget rates, Lite doesn't prompt the user to save. If the user then clicks away from the rates screen and continues on with the budget, the old rates are used. This is because the rates screen was never saved. Once the user syncs and presses save while on the rates screen, the new rates are used.

---

**Getting Help with Coeus**

If you have questions about Coeus, you can:

- Email the Coeus help desk at coeus_help@princeton.edu
- Call the Coeus Hotline at 8-7373.

---

**Acknowledgements**

Large sections of this manual are originally from the Coeus 4.4.1 Premium Proposal Development guide (which has its origins in both the MIT Coeus 4.1 Premium Proposal Development guide and the Princeton Coeus 3.8 award guide) and have been edited, updated, and revised to reflect Coeus 4.5.1.P2 and Princeton procedures.

The enthusiastic participation of the Coeus Team and Coeus testers at Princeton University and our community user testers is greatly acknowledged. We are grateful for the help of the Coeus Consortium members for their advice, guidance, and documentation, in particular the Coeus team and Consortium leaders at MIT, Sam Gannon at Vanderbilt Medical School, and Jennifer Quinn at Brown University.